
 

 

FEM Design Verification Checklist for ADAPT-Builder 2017 (Summary) 
 
 

 

© Maverick United | 4 July 2019   P a g e  | 1

   

Project Title       Job No.         

Discipline Structural File Ref.         

Review Date             Reviewer           

Project Stage             Circulation         

 

       Legend                    
 

       Pass                         
  

       Fail                         X    
 

       Not Applicable         NA  
  

 

 
 
 
 
 
 
 
 
Checklist Inclusions and Exclusions 
 

EQ Checks Included
 

Wall / Column Nodal Loads and Live Load Reduction Checks Included
 

Hinged Beam Checks Included
 

 

Wall / Column Clear Height, Effective Height and Base Support Checks Included
 

Transferred Wall / Column on Transfer Beam / Slab Checks Included
 

 

Section Properties, Torsion and Horizontal Framing Checks Included
 

Method of Slab Analysis, Beam Load Application and Frame Analysis Checks Included
 

 

Redundant Slab, Beam and Wall / Column Analysis and Design Checks Included
 

Rare Slab, Beam and Wall / Column Analysis and Design Checks Included
 

 
 

Pad Footing Checks Included
 

Strip Footing Checks Included
 

Raft / Piled Raft Footing Checks Included
 

Pile Footing Checks Included
 

 

Note that in this document, the terms steel, rebar and reinforcement refer to steel reinforcement bars associated with RC or PT 
construction, whilst the term tendon refers to tendons associated with PT construction. 
 

ITEM CONTENT  

1.0 COMPANY STANDARD TEMPLATE CHECKS  

1.1 General  

1.11 Company standard template used → MultiStorey-EQ  MultiStorey-NoEQ   

1.12 Date of release of company standard template.   

1.2 Variations to Company Standard Template  

1.21 VFS → RPT-T → Structural Geometry → Slab Regions/Beams/Walls/Columns → check 
concrete grade for slab/beam/wall/column. 
VFS → Select by Type → select Beam → Modify Item Properties → check Beam Tab 
uncracked stiffnesses (M11, M22, M33) to 1.00 and VFS → Select by Type → select 
Slab Region → Modify Item Properties → check Slab Region Tab uncracked 
stiffnesses (M11, M22) to 1.00. 
VFS → Select by Type → select Beam → Modify Item Properties → check Beam Tab 
cracked stiffnesses (M11, M22, M33) to 0.50 and VFS → Select by Type → select Slab 
Region → Modify Item Properties → check Slab Region Tab cracked stiffnesses (M11, 
M22) to 0.50. 
BA/LTD2/FEFA → select Uncracked Stiffness Modifier for Class 1 PT or Class 2 PT and 

Cracked Stiffness Modifier for RC or Class 3 PT. 

  

1.22 Braced/unbraced wall/column.   

1.23 Maximum beam/wall/column rebar diameter.   

1.24 Adoption of (unique) design links at beam supports.   

1.25 Beam section cuts (span only – once for every beam or once for every axis).   

1.26 RigidZones None. RigidZones None  

1.27 Compatibility torsion (M11=1.0) for transfer / edge beams for Class 1 PT or Class 2 
PT. 
Compatibility torsion (M11=0.5) for transfer / edge beams for RC or Class 3 PT. 

  

1.28 Foundation load combinations S+G+Q load factor (1.00, 1.02, 1.05, 1.10).   

1.29 Etcetera.    

Building SLS Load (MN) | Undecomposed | BA | LTD1 | BA+LTD1 Foundation     

 

Abbreviations 
 

ES = Every Storey         RPT-G = Reports → Single Default Reports → Graphical 
 

VSS = View Single Level Structure        RPT-T = Reports → Single Default Reports → Tabular 
 

VFS = View Full Structure         DAS = Differential (Elastic, Creep, Shrinkage) Axial Shortening         
 

BMVC = Building Model Validity Check    RDS = Results Display Settings 
 

LTD1 = VFS → Loading → Tributary Loads → Regenerate Tributaries (Adjusting for Transfer Floors) → Recalculate Loads 
 

LTD2 = VSS → FEM → Automatic Mesh Generation → Analyse Structure [Apply Fz (Vertical) Gravity Load Cases Only: LTD1] (ES) 
 

BA = VFS → FEM → Automatic Mesh Generation → Analyse Structure 
 

FEFA = VSS → FEM → Automatic Mesh Generation → Analyse Structure 
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1.3 Variations to Material Properties  

1.31 For RC models with EQ loads stabilised by moment frames or (framed) tubes, as per capacity design concepts of 
BS EN1998-1 (i.e. the optimum location and sequence of attainment of member capacity with the attainment of 
primary seismic beam plastic moment capacity prior to the attainment of primary seismic column plastic moment 
capacity), for simplicity, the steel reinforcement strength of primary seismic column longitudinal bars should be 
reduced with respect to the steel reinforcement strength of primary seismic beam longitudinal bars by the 
following factors: - 

Capacity Design Concepts 
(Optimum Location and Sequence of Attainment of Member Capacity) 

Ductility Class Element BS EN1998-1 Clause 
ADAPT-Builder 
Representation 

Ductility Class 
Medium (DCM) 

and  
Ductility Class 
High (DCH) 

Primary Seismic Beam 
cl.4.4.2.3  

MRc ≥ 1.3MRb 

Maintain longitudinal bar  
strength grade at fy 

Primary Seismic Column 
Reduce longitudinal bar  

strength grade to fy / 1.3 
 

 

1.32 For RC models with EQ loads stabilised by moment frames or (framed) tubes, as per capacity design concepts of 
BS EN1998-1 (i.e. the favourable mechanism of deformation with the primary seismic beam and primary seismic 
column elemental attainment of ductile plastic moment capacity prior to elemental attainment of brittle shear 
capacity), for simplicity, the steel reinforcement strength of primary seismic beam and primary seismic column 
shear links should be reduced with respect to the steel reinforcement strength of primary seismic beam and 
primary seismic column longitudinal bars by the following factors: - 

Capacity Design Concepts 
(Favourable Mechanism of Deformation) 

Ductility Class Element BS EN1998-1 Clause 
ADAPT-Builder 
Representation 

Ductility Class 
Medium (DCM) 

Primary Seismic Beam cl.5.4.2.2 Rd = 1.0 Reduce shear link  
strength grade to fyv / 1.1 Primary Seismic Column cl.5.4.2.3 Rd = 1.1 

Ductility Class 
High (DCH) 

Primary Seismic Beam cl.5.5.2.1 Rd = 1.2 Reduce shear link  
strength grade to fyv / 1.3 Primary Seismic Column cl.5.5.2.2 Rd = 1.3 

 

 

2.0 ARCHITECTURAL DESIGN INTENT CHECKS  

2.1 General  

2.11 File → Import → DWG/DXF → import architectural drawing and check consistency of wall/column positions (ES).  

2.12 File → Import → DWG/DXF → import architectural drawing and check consistency of slab/beam drops (ES).  

2.13 File → Import → DWG/DXF → import architectural drawing and check consistency of slab edges and openings 
(ES). 

 

2.14 Build → Construction Aids → Level Assignment → check storey labels, storey heights, h (m) including stump 
depth (hSt01 > deepest beam to ensure correct wall/column base shears) and define base level as St00. 

 

2.15 Build → Construction Aids → Level Assignment → check total building elevation, HT (m).  

3.0 FRAMING AND LOADING CHECKS  

3.1 Framing Intent  

3.11 Check floor framing intent (i.e. simple support, continuous, cantilever) is visually comprehensible.  
Check staircase framing intent (i.e. longitudinal, transverse, stiffener) is visually comprehensible.  
Check joint scheme (contraction, expansion, settlement and sway joints) is visually comprehensible.  
Check frame sizes by VSS → RPT-G → Plan Geometry → compare: - 
 
(i) slab sizes w.r.t. span to depth ratios (30 RC, 40 PT), ULS bending stress MULS/bh2  1N/mm2 << 

5N/mm2 and FEFA deflections, with MULS checked based on 1.4 x tributary width x (15.0-25.0kPa) 
x L2/12, 
 

(ii) beam sizes w.r.t. span to depth ratios (20 RC, 30 PT), ULS shear stress VULS/bh  3N/mm2 << 

5N/mm2 and ULS bending stress MULS/bh2  3N/mm2 << 5N/mm2 and FEFA deflections, with MULS 

and VULS checked based on 1.4 x tributary width x (15.0-25.0kPa) x L2/12 and 1.4 x tributary 
width x (15.0-25.0kPa) x L/2, respectively with As,prov  3000 . MULS (kNm) / d (mm), 

 
(iii) shear wall #A sizes w.r.t. scheme design ratios (for 0.4% steel, AC  FULS / [15@C35; 17@C40; 

19@C45; 21@C50; 23@C55; 25@C60] #B1, #B2 effectively equalising axial stress at every level to 
cater for DAS #C) and shear wall detailing capacity tables, with FULS checked based on 1.4 x tributary 
area x no. of storeys x (15.0-25.0kPa) #D, 
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(iv) transfer beam sizes w.r.t. ULS shear stress VULS/bh  3N/mm2 << 5N/mm2 and ULS bending stress 

MULS/bh2  3N/mm2 << 5N/mm2, ULS punching shear transfer column face stress Veff/ud  4N/mm2 

<< 5N/mm2 (applicable when transfer beam width > column width), deep beam design #E1 and BA 
and LTD2 deflections, with MULS = FULS.L/4 and VULS = FULS/2 #F1 computed from FULS checked based 

on 1.4 x tributary area x no. of storeys x (15.0-25.0kPa) #D, 
 
(v) transfer slab sizes w.r.t. ULS shear stress VULS/bh @ 1.0d  1.0N/mm2 [RC] to 1.5N/mm2 [PT] << 

5N/mm2 and ULS bending stress MULS/bh2  1.5N/mm2 [RC] to 2.5N/mm2 [PT] << 5N/mm2, ULS 

punching shear transfer column (or transfer column head where applicable) and transferred walls/columns 
face stress Veff/ud  4N/mm2 << 5N/mm2, ULS punching shear transfer column (or transfer column 

head where applicable) and transferred walls/columns first perimeter stress Veff/ud @ 1.5d  0.6N/mm2 

[RC] to 1.0N/mm2 [PT], deep beam design #E2 and CBAFE deflections, with MULS = FULS.L/4 and 
VULS = FULS/2 #F2 computed from FULS checked based on 1.4 x tributary area x no. of storeys x 
(15.0-25.0kPa) #D, 

 
(vi) column #A sizes w.r.t. scheme design ratios (for 2.0% steel, AC  FULS / [20@C35; 22@C40; 24@C45; 

26@C50; 28@C55; 30@C60] #B1, #B2 effectively equalising axial stress at every level to cater for 
DAS #C), with FULS checked based on 1.4 x tributary area x no. of storeys x (15.0-25.0kPa) #D, 

 
(vii) lateral stability frame size and extent w.r.t. scheme design ratios (height / 10) whilst confirming the 

braced/unbraced wall/column conditions based on the lateral stability system, the Moment Ratio 
Check and/or the Sway Susceptibility Check (NHF / wind: non-sway with Q/1.4 ≤ 0.05 and sway with 
Q/1.4 ≤ 0.25 with default stiffness parameters; EQ: non-sway with q.Q/0.7 ≤ 0.05 and sway with 
q.Q/0.7 ≤ 0.25 with default stiffness parameters), 

 
(viii) lateral stability frame size and extent w.r.t. lateral stability base shear magnitude distribution #G 

and lateral stability base moment magnitude distribution #H, and 
 

(ix) lateral stability frame size and extent w.r.t. lateral deflections to NHF / wind #I (total/2 ≤ Htotal/500 and 

storey,I/2 ≤ hstorey,I/500 with default stiffness parameters) and EQ #I (q.total ≤ Htotal/250 and 

q.storey,I ≤ hstorey,I/250 (with fundamental period T1/2) with default stiffness parameters), (ES). 

 
#A: Note check wall/column for Reference Planes Storeys Intervals ≥ 1 and perform BMVC. 
 
#B1 [Textual]: Note check VSS → RPT-T → Structural Geometry → Walls/Columns for sectional area, AC and BA/LTD2 → 

VSS → RPT-T → Wall/Column Reactions (max) enveloping ULS combinations axial load, FULS to calculate ULS axial stress 
FULS/AC (BA / LTD2). Note calculate % steel << 2%(shear wall vertical steel % limit for avoidance of through-thickness 
links)/5%(column vertical steel % limit) manually. 
 

#B2 [Visual]: Note check BA/LTD2 → VSS → RPT-G → Wall/Column Reactions (max) enveloping ULS combinations axial 

load, FULS to calculate ULS axial stress FULS/AC (BA / LTD2) manually or BA/LTD2 → VSS → RDS → Wall/Column → Actions 
(Diagram) → Axial Force selecting Envelope Strength combinations axial load, FULS to calculate ULS axial stress FULS/AC (BA 

/ LTD2) manually. Note check LTD1 → VSS → RDS → Load Takedown → Cumulative Loads manually factoring S, G and Q 
for ULS combinations axial load, FULS to calculate ULS axial stress FULS/AC (LTD1 only) manually. Note calculate % steel << 
2%(shear wall vertical steel % limit for avoidance of through-thickness links)/5%(column vertical steel % limit) manually. 
 

#C: Note check BA → VSS → RDS → Wall/Column → Deformation → Z-Translation for DAS and BA → VSS → RDS → 
Wall/Column → Deformation → rr/ss-Translation for lateral deflection (sway) of the building due to DL+SDL+LL+PT. The SLS 
load combination inherently includes the effects of differential (elastic, creep, shrinkage) axial shortening. Staged construction 
analysis may be performed to reduce the magnitude of the effects of differential (elastic, creep, shrinkage) axial shortening. 
 

#D: Note check BA → VSS → RDS → Vibration for animated deflections for spurious members and BA → VFS → RDS → 
Wall/Column → Actions (Diagram) → Axial Force ensuring gradual wall/column axial load increment and check BA/LTD2 

→ VSS → RPT-T → Wall/Column Reactions for minimal discrepancy between BA and LTD2 wall/column axial load 
take down by ensuring minimal differential beam support (i.e. wall/column point) settlement (due to DAS and differential 
transfer floor deflection) in BA/FEFA → VSS → RDS → Wall/Column → Deformation → Z-Translation !. The ULS load 
combinations inherently include the effects of differential (elastic, creep, shrinkage) axial shortening. Staged construction 
analysis may be performed to reduce the magnitude of the effects of differential (elastic, creep, shrinkage) axial shortening. 
 
#E1: Note check (a) transfer beam / transferred wall strut and tie truss analogy design for the transferred wall (acting as 
the diagonal compression element with the provision of horizontal steel equivalent to ¼ of the required vertical steel) and 
transfer beam (acting as the tension element with the provision of rebar of 0.95fy.As,prov to resist FULS/4 over the transfer beam 

depth of span/3), (b) transfer beam deep beam design with As,prov  3800 . MULS (kNm) / h (mm), (c) transfer beam 

longitudinal shear within web and between web and flanges and (d) transfer beam torsion design. 
 
#E2: Note check (a) transfer slab / transferred wall strut and tie truss analogy design for the transferred wall (acting as 
the diagonal compression element with the provision of horizontal steel equivalent to ¼ of the required vertical steel) and 
transfer slab (acting as the tension element with the provision of rebar of 0.95fy.As,prov to resist FULS/4 over the transfer slab 

depth of span/3), (b) transfer slab deep beam design with As,prov  3800 . MULS (kNm) / h (mm) and (c) transfer slab 
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longitudinal shear within web. 
 
#F1: Note check BA/LTD2 → VSS → RDS → Beam → Actions (Diagram) → Moment About zz for minimal discrepancy 
between BA and LTD2 transfer beam bending moments by ensuring minimal differential transfer beam support (i.e. 
wall/column point) settlement (due to DAS) !. The ULS load combinations inherently include the effects of differential (elastic, 
creep, shrinkage) axial shortening. Staged construction analysis may be performed to reduce the magnitude of the effects of 
differential (elastic, creep, shrinkage) axial shortening. 
 

#F2: Note check BA/LTD2 → VSS → RDS → Slab → Actions (Contour Map) → |Mxx|+|Mxy| and |Myy|+|Mxy| for minimal 
discrepancy between BA and LTD2 transfer slab bending moments by ensuring minimal differential transfer slab 
support (i.e. wall/column point) settlement (due to DAS) !. The ULS load combinations inherently include the effects of 
differential (elastic, creep, shrinkage) axial shortening. Staged construction analysis may be performed to reduce the 
magnitude of the effects of differential (elastic, creep, shrinkage) axial shortening. 
 

#G: Note check VSS → RPT-T → Structural Geometry → Walls/Columns for sectional area, AC and BA → VSS → RPT-T → 

Wall/Column Reactions (max) enveloping ULS combinations shear force, VULS to calculate ULS shear stress  = VULS/AC  

3N/mm2 (based on nominal link provision for vertical elements loaded to 40%fcu at ULS i.e. the capacity for a 0.4% steel 
reinforced vertical element) << 5N/mm2 for all stability base shear resisting elements i.e. shear walls above transfer and 
shear walls / mega columns below transfer. 
 
#H: Note ensure no foundation uplift. 
 
#I: Note check on-plan torsional twist due to NHF, wind and EQ loads. 

3.2 Slab Loads  

3.21 VSS → Loading → Add Load → Patch Load Wizard → add slab LL (ES). 
VSS → RPT-G → Loading → Live Load → check slab LL (ES). 

 

3.22 VSS → Loading → Add Load → Patch Load Wizard → add slab SDL (ES). 
VSS → RPT-G → Loading → Dead Load → check slab SDL (ES). 

 

3.23 VSS → Loading → Add Load → Point, Line and Patch Load → add slab point, line and partial patch load (ES). 
VSS → RPT-G → Loading → Live Load and Dead Load → check slab point, line and partial patch loading visually 

(ES). 

 

3.3 Beam Loads  

3.31 VSS → Loading → Add Load → Line Load → add beam internal cladding line load (ES). 
VSS → RPT-G → Loading → Dead Load → check beam internal cladding line load visually (ES). 

 

3.32 VSS → Loading → Add Load → Line Load → add beam external cladding line load (ES). 
VSS → RPT-G → Loading → Dead Load → check beam external cladding line load visually (ES). 

 

3.33 VSS → Loading → Add Load → Line Load → add beam user defined line loads (ES). 
VSS → RPT-G → Loading → Live Load and Dead Load → check beams with user defined line loads visually (ES). 

 

3.4 Wall/Column Loads  

3.41 VSS → Loading → Add Load → Point Load → add wall/column user defined point loads (ES). 
VSS → RPT-G → Loading → Live Load and Dead Load → check wall/column user defined point loads visually 
(ES). 

 

3.5 Lateral Loads  

3.51 VSS → Loading → Add Load → Patch Load Wizard → add NHF loads (ES). 
VSS → RPT-G → Loading → User Defined Load Cases → check NHF loads (ES). 
VFS → Loading → Add Load → Wind Load Wizard → add wind loads (ES). 
VSS → RPT-G → Loading → User Defined Load Cases → check wind loads (ES). 

 

3.52 VFS → Loading → Add Load → Seismic Load Wizard → add EQ loads (ES). 
VSS → RPT-G → Loading → User Defined Load Cases → check EQ loads (ES). 

 

3.6 Imposed Load Reduction  

3.61 Loading → Live Load Reduction → check live load reduction factors. Note that live load reduction option must 

also be checked on the Load Combination table for applicability. 
 

3.7 Load Combination Cases  

3.71 Note for EQ ULS load combination cases, if required by cl.4.3.3.5.2 BS EN1998-1 i.e. if avg is greater than 0.25g, 
then the vertical component of the seismic action will need to be incorporated as follows: - 
 1.0DL+1.0SDL+2iLL+HYP1.0EQX0.3EQY0.3EQZ 

 1.0DL+1.0SDL+2iLL+HYP0.3EQX1.0EQY0.3EQZ 

      by enhancing G to G+0.3EQZ where EQZ is the total EQ base shear in Z and G is DL+SDL, and for 
 1.0DL+1.0SDL+2iLL+HYP0.3EQX0.3EQY1.0EQZ 

      by enhancing G to G+1.0EQZ where EQZ is the total EQ base shear in Z and G is DL+SDL. 
Note for EQ SLS load combination cases, if required by cl.4.3.3.5.2 BS EN1998-1 i.e. if avg is greater than 0.25g, 
then the vertical component of the seismic action will need to be incorporated as follows: - 
 1.0DL+1.0SDL+2iLL+PT1.0EQX0.3EQY0.3EQZ 
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 1.0DL+1.0SDL+2iLL+PT0.3EQX1.0EQY0.3EQZ 

      by enhancing G to G+0.3EQZ where EQZ is the total EQ base shear in Z and G is DL+SDL, and for 
 1.0DL+1.0SDL+2iLL+PT0.3EQX0.3EQY1.0EQZ 

      by enhancing G to G+1.0EQZ where EQZ is the total EQ base shear in Z and G is DL+SDL. 

Note effectively both the DL+SDL and LL components within the dynamic weight W is lumped into the enhanced 
load factor for G. 

3.72 Note for EQ ULS load combination cases, as required by cl.6.4.3.4 BS EN1990, the combination coefficient for 
variable action, 2i will need to be recalculated as per T.A1.1 BS EN1990. 

 1.0DL+1.0SDL+2iLL+HYP1.0EQX 

 1.0DL+1.0SDL+2iLL+HYP1.0EQY 

 1.0DL+1.0SDL+2iLL+HYP1.0EQX0.3EQY0.3EQZ 

 1.0DL+1.0SDL+2iLL+HYP0.3EQX1.0EQY0.3EQZ 

 1.0DL+1.0SDL+2iLL+HYP0.3EQX0.3EQY1.0EQZ 

Note for EQ SLS load combination cases, as required by cl.6.4.3.4 BS EN1990, the combination coefficient for 
variable action, 2i will need to be recalculated as per T.A1.1 BS EN1990. 

 1.0DL+1.0SDL+2iLL+PT1.0EQX 

 1.0DL+1.0SDL+2iLL+PT1.0EQY 

 1.0DL+1.0SDL+2iLL+PT1.0EQX0.3EQY0.3EQZ 

 1.0DL+1.0SDL+2iLL+PT0.3EQX1.0EQY0.3EQZ 

 1.0DL+1.0SDL+2iLL+PT0.3EQX0.3EQY1.0EQZ 

 

4.0 BOUNDARY CONDITION CHECKS  

4.1 Beam/Column Releases  

4.11 VFS → Select by Type → select Beam → Modify Item Properties → check Beam Tab releases are unselected 
(ES). 

 

4.12 Check beams on corbels are defined with hinged ends (ES).  

4.13 Check stepped secondary beams across primary beams are defined with hinged ends for steps of a dimension 
greater than the width of the primary beam (ES). 

 

4.14 Check beams of depths significantly larger than the thickness of the supporting wall (orientated perpendicular to 
the longitudinal beam direction) e.g. basement retaining wall or lift core wall and beams of widths significantly 
larger than the thickness of the supporting wall (orientated parallel to the longitudinal beam direction) are 
defined with hinged ends with a nominal 50% of span steel defined at the hinged supports (ES). 

 

4.2 Wall/Column Clear Height  

4.21 Wall/Column Clear Height Calculation 

Item Wall Clear Height Column Clear Height 

Beam Depths Not Included Not Included 

Beam Drops or Elevation  
Vertical Offset 

Included only if a corresponding 
Vertical Offset definition is 
specified for the wall in the 

particular storey and the storey 
above 

Included only if a corresponding 
Offset-z definition is specified for 

the column in the particular 
storey and the storey above 

Multiple Storey  
Wall/Column Spans 

Included only if the number of 
storeys that the wall spans is 
specified in Reference Planes 

Storeys Intervals #A 

Included only if the number of 
storeys that the column spans is 

specified in Reference Planes 
Storeys Intervals #A 

#A: VFS → RPT-T → Structural Geometry → Walls/Columns → check walls/columns Reference Planes Storey Intervals 
definition indirectly by checking walls/columns length, noting that only walls/columns that are strutted/tied in both 
directions may be considered Reference Planes Storeys Intervals = 1 (ES). Struts/ties should be capable of resisting 
2.5% of the design ultimate vertical load that the wall/column is designed to carry at the point of lateral support as 
stipulated by cl.3.9.2.3 BS8110-1. Note that the struts/ties should be at least 1/10th of the stiffness of the columns, i.e. 

Ibeam/Lbeam ≥ 0.10[Icolumn/Lcolumn] to be effective as suggested by cl.2.5.4 BS8110-2 and is to be fully restrained by a 

horizontal diaphragm (floor slab, note that flat slab also constitutes a horizontal diaphragm), failing which the summation of 
beam stiffnesses of at least 1/10th of the summation of column stiffnesses is mandatory. 

 

4.22 Recognition of Reference Planes Storeys Intervals ≥ 2 Wall/Column As Beam Supports  
for Beams Not on the Wall/Column Defined Storey 

Item BA FEFA 

Wall Recognized Recognized 

Column Recognized Recognized 
 

 

4.3 Wall/Column Effective Length Factor  

4.31 Check Braced adopted for walls/columns in a lateral stability system (ES): -  
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(i) that exist in a coupled shear wall (minor plane only) / outrigger frame (outrigger columns only) 
/ (framed) tube flange / (framed) tube web (minor plane only) lateral stability system (cl.3.8.1.5 
BS8110-1), and 

(ii) that have a total (of all walls/columns in question) gross stiffness ≤ 1/12th of the total gross 
stiffness of the bracing elements resisting lateral movement of that storey (cl.6.2.5 ACI 318-14), and 

(iii) that exhibit a total (of all walls/columns in question) magnitude of shear force and bending moment 
(excluding the bending moment back-calculated by multiplying the push-pull axial forces of the 
walls/columns at the frame extremity) based on the Moment Ratio Check ≤ 1/12th of the total 
magnitude of shear force and bending moment (including ditto) of the bracing elements resisting lateral 
movement of that storey (inferred from cl.6.2.5 ACI 318-14), and 

(iv) that are within a sway storey (exhibiting Q ≤ 0.25 or   4.0) based on the Sway Susceptibility Check 

but with elastic second-order analysis / P- analysis / lateral loads (wind, EQ) amplification with the 

amplified sway factor, m = /(−1) performed (cl.6.2.6 and cl.R6.7.1.2 ACI 318-14), or (albeit 

unconservatively) 
(v) that are within a non-sway storey (exhibiting Q ≤ 0.05 or   20) based on the Sway Susceptibility 

Check (based on cl.6.6.4.3(b) ACI 318-14). 
Note that for significant buildings, based on a (vertical load take down, base lateral load distribution and 
lateral drift verified) CSI.Etabs model, a first principle eigenvalue buckling analysis should be performed to 
confirm the global building buckling characteristics (requiring   4.0 to cl.R6.2.6 ACI 318-14 and to verify 

the value for m in m = /(−1)) and local mega column buckling characteristics ((requiring   1). 

4.32 Check Unbraced adopted for walls/columns in a lateral stability system (ES): - 
(i) that exist in a coupled shear wall (major plane only) / moment frame / outrigger frame (except 

outrigger columns) / (framed) tube web (major plane only) lateral stability system (cl.3.8.1.5 
BS8110-1), or 

(ii) that have a total (of all walls/columns in question) gross stiffness > 1/12th of the total gross 
stiffness of the bracing elements resisting lateral movement of that storey (cl.6.2.5 ACI 318-14), or 

(iii) that exhibit a total (of all walls/columns in question) magnitude of shear force or bending moment 
(excluding the bending moment back-calculated by multiplying the push-pull axial forces of the 
walls/columns at the frame extremity) based on the Moment Ratio Check > 1/12th of the total 
magnitude of shear force or bending moment (including ditto) of the bracing elements resisting lateral 
movement of that storey (inferred from cl.6.2.5 ACI 318-14), and (albeit unconservatively) 

(iv) that are within a sway storey (exhibiting Q > 0.05 or  < 20) based on the Sway Susceptibility Check 

(based on cl.6.6.4.3(b) ACI 318-14). 
Note that for significant buildings, based on a (vertical load take down, base lateral load distribution and 
lateral drift verified) CSI.Etabs model, a first principle eigenvalue buckling analysis should be performed to 
confirm the global building buckling characteristics (requiring   4.0 to cl.R6.2.6 ACI 318-14 and to verify 

the value for m in m = /(−1)) and local mega column buckling characteristics ((requiring   1). 

 

4.33 Check manually Edited Bracing adopted for walls/columns in structures with transferred lateral stability (e.g. 
braced shear wall residential block on an unbraced moment frame car park podium, noting that should the 
car park podium floors be constructed in flat slabs instead of in beams and slabs, the unbraced mega columns 
beneath the transfer floor would effectively resist a primary stability base shear induced vierendeel moment over 
its height from the transfer floor to a base level that can effectively transfer the stability base shear into the 
foundations unless, and as highly recommended, a certain proportion of the existing shear walls are continued 
below the transfer floor to the foundations or if new shear walls are introduced below the transfer floor, yielding 
a scenario akin to the core and outrigger form of stability whereby the stability base moment is resolved into 
axial forces into the then braced (provided cl.6.2.5 and conservatively cl.6.6.4.3(b) ACI 318-14 are satisfied 
for a non-sway storey) mega columns and the stability base shear is transferred by the transfer floor diaphragm 
to the shear walls beneath the transfer floor into the foundations; note that even if the car park podium floors 
were constructed in beams and slabs, it is likely that the stability base shear will migrate to the usually stiffer 
shear walls if they are provided; note that a ULS shear stress check should be done on all stability base shear 
resisting elements) (ES). 

 

4.4 Wall/Column Base Support Conditions  

4.41 RPT-T → Structural Geometry → Releases and Restraints → check user-defined supports (Build → Support → 
Point and Line Supports → introduce lateral and rotational flexibility): - 
Pad, Strip, Raft, Piled Raft Foundations 
- Introduce lateral flexibility in both directions in accordance with soil stiffness. 
- Introduce zero rotational flexibility in both planes. 
Piled Foundations (with Dropped or Integrated Pile Caps) 
- Introduce lateral flexibility in both directions in accordance with soil stiffness. 
- Introduce rotational flexibility in both planes for single-pile pile caps and one plane for double-pile pile caps. 

 

4.42 Check stepped foundations levels relative to St00 (e.g. general pile cap level compared to the lift pit pile cap 
level) defined with -ve Offset-z (bot) upwards in the St01 wall/column definitions. 

 

4.43 Check stepped foundations levels relative to St0i where i≥1 defined with -ve Offset-z (bot) upwards and Point 
and Line Supports defined in St0i+1 wall/column definitions (check user-defined supports) noting that user-
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defined support types are defined in Build → Support → Point and Line Supports. Alternatively, wall/column 
definitions at St0i+1 where i≥1 may be defined with Reference Planes Storeys Intervals ≥ 2 and -ve Offset-z 
(bot) upwards defined to extend beyond the storey height(s). 

5.0 MODELLING CHECKS  

5.1 General  

5.11 Check all elements modelled with their analytical footprint matching their physical footprint (ES).  

5.12 Check that secondary beam spans break at primary beam crossings and that primary beam spans break at 
wall/column crossings (ES). 
Check that offset beams (which are secondary beams that frame into the beam in question within the footprint 
of the wall/column) are avoided as far as it is practical (ES). 

 

5.13 Check 3D visualization (Adapt Solid Modelling) for accuracy of modelling in particular: - 
• slab and beam drops and soffit continuity (ES). 
• consistency of inter-storey wall/column setting out (ES). 
• multi-storey (Reference Planes Storeys Intervals > 1) wall/column element spans, noting that only 

walls/columns that are strutted/tied in both directions may be considered Reference Planes 
Storeys Intervals = 1 (ES). 

 

5.14 Check validity of slab contributing to floor diaphragm for all dropped slabs, inclined slabs, slabs near inclined 
walls/columns and conservatively slabs near basement retaining walls to ensure that the stability base shear is 
resisted by the walls/columns supporting the superstructure (ES). 

 

5.15 Check all cantilever beams are identified as such (ensuring the correct cantilever reinforcement detailing and the 
correct deflection assessment based on cantilever span / depth ratios) (ES). 

 

5.16 Check all similar storeys are defined with their correct storey height to ensure that wall/column clear heights are 
accurately calculated. 

 

5.2 Section and Material Properties  

5.21 % Reduction in Rigidity in BA #A 

Action Slab/Beam Wall/Column 

ULS DL, SDL, LL (V) #B Class 1 PT or Class 2 PT 
50%{EA} Uncracked, Creep 
50%{EI} Uncracked, Creep 

50%{GAs} Uncracked, Creep 
50%{GJ} Uncracked, Creep 

kE=1.0, kI=1.0, kJ=1.0, kA=1.0 
[2.0 x Default Parameters] 

RC or Class 3 PT 
50%{EA} Uncracked, Creep 

25%{EI} Cracked, Creep 
50%{GAs} Uncracked, Creep 

25%{GJ} Cracked, Creep 
kE=1.0, kI=0.5, kJ=0.5, kA=1.0 

[Default Parameters] 

Class 1 PT, Class 2 PT, 
RC or Class 3 PT 

50%{EA} Uncracked, Creep 
50%{EI} Uncracked, Creep 

50%{GAs} Uncracked, Creep 
50%{GJ} Uncracked, Creep 

kE=1.0, kI=1.0, kJ=1.0, kA=1.0 
[Default Parameters] 

ULS NHF (H) #B 

ULS Wind (H) #B 

SLS DL, SDL, LL (V) #C 

ULS EQ (H) #B, #F 

Class 1 PT or Class 2 PT 
50%{EA} Uncracked, Creep 
50%{EI} Uncracked, Creep 

50%{GAs} Uncracked, Creep 
50%{GJ} Uncracked, Creep 

kE=1.0, kI=1.0, kJ=1.0, kA=1.0 
[2.0 x Default Parameters] 

RC or Class 3 PT 
50%{EA} Uncracked, Creep 

25%{EI} Cracked, Creep 
50%{GAs} Uncracked, Creep 

25%{GJ} Cracked, Creep 
kE=1.0, kI=0.5, kJ=0.5, kA=1.0 

[Default Parameters] 

Class 1 PT, Class 2 PT, 
RC or Class 3 PT 

50%{EA} Uncracked, Creep 
25%{EI} Cracked, Creep 

50%{GAs} Uncracked, Creep 
25%{GJ} Cracked, Creep 

kE=1.0, kI=0.5, kJ=0.5, kA=1.0 
[~0.5 x Default Parameters] 

SLS NHF (H) #C, #D Class 1 PT or Class 2 PT 
100%{EA} Uncracked, No Creep 
100%{EI} Uncracked, No Creep 

100%{GAs} Uncracked, No Creep 
100%{GJ} Uncracked, No Creep 
kE=2.0, kI=1.0, kJ=1.0, kA=1.0 

[4.0 x Default Parameters] 

Class 1 PT, Class 2 PT, 
RC or Class 3 PT 

100%{EA} Uncracked, No Creep 
100%{EI} Uncracked, No Creep 

100%{GAs} Uncracked, No Creep 
100%{GJ} Uncracked, No Creep 
kE=2.0, kI=1.0, kJ=1.0, kA=1.0 

SLS Wind (H) #C, #D 

SLS Vibration (H) #C, #D 
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RC or Class 3 PT 
100%{EA} Uncracked, No Creep 

50%{EI} Cracked, No Creep 
100%{GAs} Uncracked, No Creep 

50%{GJ} Cracked, No Creep 
kE=2.0, kI=0.5, kJ=0.5, kA=1.0 

[2.0 x Default Parameters] 

[2.0 x Default Parameters] 

SLS EQ (H) #C, #D, #F 

Class 1 PT or Class 2 PT 
100%{EA} Uncracked, No Creep 
100%{EI} Uncracked, No Creep 

100%{GAs} Uncracked, No Creep 
100%{GJ} Uncracked, No Creep 
kE=2.0, kI=1.0, kJ=1.0, kA=1.0 

[4.0 x Default Parameters] 

RC or Class 3 PT 
100%{EA} Uncracked, No Creep 

50%{EI} Cracked, No Creep 
100%{GAs} Uncracked, No Creep 

50%{GJ} Cracked, No Creep 
kE=2.0, kI=0.5, kJ=0.5, kA=1.0 

[2.0 x Default Parameters] 

Class 1 PT, Class 2 PT, 
RC or Class 3 PT 

100%{EA} Uncracked, No Creep 
50%{EI} Cracked, No Creep 

100%{GAs} Uncracked, No Creep 
50%{GJ} Cracked, No Creep 

kE=2.0, kI=0.5, kJ=0.5, kA=1.0 
[~1.0 x Default Parameters] 

ULS Sway Susceptibility 
(NHF) (H) #E 

Class 1 PT or Class 2 PT 
100%{EA} Uncracked, No Creep 
70%{EI} Uncracked, No Creep 

100%{GAs} Uncracked, No Creep 
70%{GJ} Uncracked, No Creep 
kE=2.0, kI=0.7, kJ=0.7, kA=1.0 
[~2.8 x Default Parameters] 

RC or Class 3 PT 
100%{EA} Uncracked, No Creep 

35%{EI} Cracked, No Creep 
100%{GAs} Uncracked, No Creep 

35%{GJ} Cracked, No Creep 
kE=2.0, kI=0.35, kJ=0.35, kA=1.0 

[~1.4 x Default Parameters] 

Class 1 PT, Class 2 PT, 
RC or Class 3 PT 

100%{EA} Uncracked, No Creep 
70%{EI} Uncracked, No Creep 

100%{GAs} Uncracked, No Creep 
70%{GJ} Uncracked, No Creep 
kE=2.0, kI=0.7, kJ=0.7, kA=1.0 
[~1.4 x Default Parameters] 

ULS Sway Susceptibility 
(Wind) (H) #E 

ULS Sway Susceptibility 
(EQ) (H) #E, #F 

Class 1 PT or Class 2 PT 
100%{EA} Uncracked, No Creep 
70%{EI} Uncracked, No Creep 

100%{GAs} Uncracked, No Creep 
70%{GJ} Uncracked, No Creep 
kE=2.0, kI=0.7, kJ=0.7, kA=1.0 
[~2.8 x Default Parameters] 

RC or Class 3 PT 
100%{EA} Uncracked, No Creep 

35%{EI} Cracked, No Creep 
100%{GAs} Uncracked, No Creep 

35%{GJ} Cracked, No Creep 
kE=2.0, kI=0.35, kJ=0.35, kA=1.0 

[~1.4 x Default Parameters] 

Class 1 PT, Class 2 PT, 
RC or Class 3 PT 

100%{EA} Uncracked, No Creep 
35%{EI} Cracked, No Creep 

100%{GAs} Uncracked, No Creep 
35%{GJ} Cracked, No Creep 

kE=2.0, kI=0.35, kJ=0.35, kA=1.0 
[~0.7 x Default Parameters] 

#A: These values of kE, kI, kJ and kA within the table are formulated based on the premise that the elastic modulus, E value 
has been reduced to account for creep effects as the default. The reduction to the elastic modulus, E of 0.50 for typical office / 
residential buildings as stipulated by cl.14.5.2 of Report 110 Design of RC Flat Slabs to BS8100 (CIRIA) pp.34 is adopted. 
#B: RC or Class 3 PT stiffness values for ULS design governed by 1.00Ig (wall, column) and 0.50Ig (slab) of TR.64 Guide to 
the Design and Construction of RC Flat Slabs (The Concrete Society) pp.31 and by cl.14.5.4 of Report 110 Design of RC Flat 
Slabs to BS8100 (CIRIA) pp.35 are adopted. The RC or Class 3 PT ratio of relative stiffness for ULS design between (wall, 
column) : (slab, beam) elements of 1.00 : 0.50 is also suggested by cl.6.6.3.1.1 ACI 318-14, i.e. in 0.70 : 0.35 although the 
stiffness reduction factor 0.70 is not adopted here as would have a somewhat negligible effect on the ULS effects. Creep on the 
other hand is included for ULS effects to cater for the additional effects generated by differential (elastic, creep, shrinkage) 
axial shortening of walls/columns. 
#C: RC or Class 3 PT stiffness values for SLS design governed by 0.70Ig (wall, column), 0.35Ig (beam) and 1.00Ag (beam, 
wall, column) of cl.6.6.3.1.1 ACI 318-14 together with a 1.4 multiplier stipulated within cl.6.6.3.2.2 ACI 318-14 resulting in 
1.00Ig (wall, column), 0.50Ig (beam) and 1.00Ag (beam, wall, column) are adopted. Similar RC or Class 3 PT stiffness values 
for SLS design of 1.00Ig (wall, column) and 0.50Ig (slab) are also suggested by TR.64 Guide to the Design and Construction of 
RC Flat Slabs (The Concrete Society) pp.31 and by cl.14.5.4 of Report 110 Design of RC Flat Slabs to BS8100 (CIRIA) pp.35. 
#D: The elastic modulus, E value incorporating creep effects is still adopted for ULS NHF / ULS wind / ULS EQ as part of the 
ULS load combination cases involving vertical loads (even though wind / EQ are short-term phenomena), as the effect of which 
is deemed negligible as the ratio of stiffness between (wall, column) and (slab, beam) elements is similar to their ratio of 
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stiffness without incorporating creep effects. On the other hand, for SLS NHF / SLS wind / SLS EQ / SLS vibration design, the 
elastic modulus, E without incorporating creep effects is employed. 
#E: RC or Class 3 PT stiffness values for ULS design governed by 0.70Ig (wall, column), 0.35Ig (beam) and 1.00Ag (beam, 
wall, column) of cl.6.6.3.1.1 ACI 318-14 are adopted. Further, it is given in cl.R6.6.4.3 ACI 318-14 that if the lateral load 
deflections of the frame are calculated using service loads and the service load moments of inertia given in cl.6.6.3.2.2, it is 
permissible to calculate Q using 1.2 times the sum of the service gravity loads, the service load story shear, and 1.4 times the 
first order service load story deflections. 
#F: Note that in certain circumstances, it may be deemed more appropriate to employ cracked 0.50Ig (wall, column) stiffness 
properties for ULS EQ or SLS EQ effects due to the large displacements involved as suggested by T.9.1 of the Manual for the 
Seismic Design of Steel and Concrete Buildings to EC8 (IStructE) pp.61. 

5.22 Check slab cover 25mm internal and 40mm external (e.g. ground, podium deck, swimming pool, water tank, 
roof) (ES). 

 

5.23 VFS → Select by Type → select Beam → Modify Item Properties → check Beam Tab torsional stiffness M11 (i.e. 
the torsional constant factor) = {0.01 Class 1 PT or Class 2 PT | 0.01 RC or Class 3 PT} for models without 
equilibrium torsional beams. 

 

5.24 VFS → Select by Type → select Beam → Modify Item Properties → check Beam Tab torsional stiffness M11 (i.e. 
the torsional constant factor) = {1.00 Class 1 PT or Class 2 PT | 0.50 RC or Class 3 PT} for models with 
equilibrium torsional beams (e.g. curved beams and straight beams that frame eccentrically to columns 
(especially heavily loaded beams in transfer floors)). Torsional stiffness may also be considered for: - 
(i) heavily loaded straight transfer beams, and 
(ii) straight edge beams in regular buildings 
experiencing significant compatibility torsion. 

 

5.25 Equilibrium and Compatibility Torsion 

Scenario Equilibrium Torsion Compatibility Torsion 

Straight (Between Columns) 
Continuous Primary Beams 

Not Generated Generated 

Facetted (Between Columns) 
Continuous Primary Beams 

Generated Generated 

Curved (Between Columns) 
Continuous Primary Beams 

Generated Generated 
 

 

5.26 For models with EQ loads stabilised by moment frames, as per the requirements of BS EN1998-1, the following 
geometrical constraints need to be achieved: - 
(a) as per cl.5.4.1.2.1 and cl.5.5.1.2.1, 

primary seismic beam eccentricity, e ≤ column orthogonal dim, bc / 4 (DCM, DCH) 
primary seismic beam width, bw ≤ min {column orthogonal dim, bc + beam depth, hw, 2bc} (DCM, DCH) 
primary seismic beam width, bw ≥ 200mm (DCH) 

(b) as per cl.5.4.1.2.2 and cl.5.5.1.2.2, 
primary seismic column width, hc ≥ (column clear height, lcl / 2) / 10 (DCM, DCH) 
primary seismic column width, hc ≥ 250mm (DCH) 

 

5.27 For models with EQ loads stabilised by stability walls, as per the requirements of BS EN1998-1, the following 
geometrical constraints need to be achieved: - 
(a) as per cl.5.4.1.2.3 and cl.5.5.1.2.3, 

ductile wall thickness, bwo ≥ max {150mm, clear storey height, hs / 20} (DCM, DCH) 
(b) as per cl.5.4.3.4.2 and cl.5.5.3.4.5, 
 ductile wall boundary element requirements (DCM, DCH) 

 

5.3 Element Horizontal Framing  

5.31 Requirement of Element to Frame Horizontally (Within the Same Storey)  
onto Element Insertion Point / Line (or Simply Within the Element Footprint on Plan) 

Element Slab Beam Wall Column 

Slab N/A Not Required #A Not Required #B Not Required #C 

Beam N/A Not Required #D Not Required #E Not Required #E 

Wall N/A N/A Not Required #F Not Required #F 

Column N/A N/A N/A N/A 

#A: Check slab footprint frame need only frame onto (or through) footprint of beam (ES). 
#B: Check slab footprint frame need only frame onto (or through) footprint of wall (ES). 
#C: Check slab footprint frame need only frame onto (or through) footprint of column (ES). 
#D: Check secondary beam footprint need only frame onto footprint of primary beam (ES). 
#E: Check primary beam footprint need only frame onto footprint of wall/column (ES). 
#F: Check wall footprint need only frame onto footprint of wall/column (ES). 

Note that in all cases above, no element may frame through the other element (but instead only onto element 
insertion point/line or within the element footprint), unless specifically denoted otherwise. 
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5.32 
Element 

Method 1  
(Insignificant Drops) 

Method 2 
(Significant Drops) 

Slab N/A 
Defining drops by +ve Vertical Offset downwards (and elevation 

–ve Vertical Offset upwards) 

Beam N/A 
Defining drops (inclination N/A) by +ve Vertical Offset 
downwards (and elevation –ve Vertical Offset upwards) 

Wall N/A 
Defining drops by +ve Vertical Offset (top) downwards (and 

elevation –ve Vertical Offset (top) upwards) 

Column N/A 
Defining drops by +ve Offset-z (top) downwards (and elevation 

–ve Offset-z (top) upwards) 
 

 

5.4 Element Vertical Framing  

5.41 Requirement of Element to Frame Vertically (Between Storeys)  
onto Element Insertion Point / Line (or Simply Within the Element Footprint on Plan) 

Element Slab Beam Wall Column 

Slab N/A N/A N/A N/A 

Beam N/A N/A N/A N/A 

Wall Not Required #A Not Required #B2 Not Required #B1, #C Not Required #B1 

Column Not Required #D Not Required #E Not Required #F Not Required #F 

#A: Check wall footprint need only frame onto footprint of transfer slab (ES). 
#B1: Check wall footprint need only frame onto footprint of transfer column. Manually perform the strut and tie truss 
analogy design for the transferred wall and the transferred wall bearing stress check to 0.40fcu at supports (over the 
minimum of the length of the support or 0.2 x clear span, ref. CIRIA Guide 2 and thickness of the transferred wall) for the 
transferred wall (ES). 
#B2: Check wall footprint need only frame onto footprint of transfer beam. Manually perform the strut and tie truss 
analogy design for the transferred wall (acting as the diagonal compression element) and transfer beam (acting as the 
tension element). Manually perform the deep beam design for the transfer beam. (ES). 
#C: Check wall footprint need only frame onto footprint of wall (ES). 
#D: Check column footprint need only frame onto footprint of transfer slab (ES). 
#E: Check column footprint need only frame onto footprint of transfer beam (ES). 
#F: Check column footprint need only frame onto footprint of wall/column (ES). 

 

5.42 Check employment of FE Shell Model (with mesh size being reduced until convergence of the wall axial forces 
and bending moments) idealisation (Mid-Pier idealisation N/A) for transferred walls at the transfer level for a 
greater distribution of load and the realistic adoption of the wall contribution to the load transfer. 

 

5.43 Check for transferred walls framing across multiple transfer walls / transfer columns / transfer beams along the 
same axis that the FE Shell Model idealisation (Mid-Pier idealisation N/A) is used. 

 

5.44 Check transfer wall / transfer beam and transferred wall are modelled with their analytical footprint matching 
their physical footprint and centroid coincident with each other as beam torsions due to any relative offset will 
not be generated as beam rigid links are not created. Check transfer column / transfer beam and transferred 
column are modelled with their physical footprint centroid coincident with each other. 

 

5.45 Modelling of Transferred Walls 

Transfer
red Wall 

Transfer 
Wall/ 

Column 
#C 

Rigid 
Zones 

Overlap 
#A 

Remark 

Wall #B Wall #B None 
No 

Overlap 
• Correct flexible representation of transfer beam bending 

moment and shear force effects 

Wall #B Column None 
No 

Overlap 
• Correct flexible representation of transfer beam bending 

moment and shear force effects 

Wall #B Wall #B None #D 
Full / 
Partial 

Overlap 

• Correct flexible representation of transfer beam bending 
moment and shear force effects 

Wall #B Column None 
Full / 
Partial 

Overlap 

• Correct flexible representation of transfer beam bending 
moment and shear force effects 

Wall #B Wall #B Max 
No 

Overlap 
N/A 

Wall #B Column Max 
No 

Overlap 
N/A 

Wall #B Wall #B Max #D 
Full / 
Partial 

Overlap 
N/A 
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Wall #B Column Max 
Full / 
Partial 

Overlap 
N/A 

#A: Overlap refers to overlap between transferred wall and transfer wall/column. 
#B: Wall refer to FE Shell Model wall (Mid-Pier wall N/A). For FE Shell Model walls, smaller shell mesh sizes should be 
investigated until convergence of the maximum support shear force effects on transfer beams. 
#C: With regards to the wall/column effective length calculation, the clear height computation for walls/columns does not 
incorporate the reduction due to the depth of the incoming beam(s). 
#D: Check for models with transferred walls overlapping with transfer walls/columns, specify RigidZones as None in BA or 
FEFA (RigidZones as Maximum N/A). As an alternative to specifying RigidZones as Maximum, specify walls instead of columns 
to effectively model columns with rigid beam arms. 

5.5 Housekeeping  

5.51 VFS → Select by Type → select Slab Region / Beam → Tools → Reset Labels → All → re-label all slabs and 
beams independently between storeys. 

 

5.52 VFS → Select by Type → select Wall / Column → Tools → Reset Labels → For Column/Wall Stacks → re-label all 
walls and columns consistently between storeys. 

 

5.6 Model Integrity  

5.61 VSS → Select/Set View Items → select Slab Region/Beam/Wall/Column ID → check for overlapping 
slabs/beams/walls/columns (ES). 
BMVC → VFS → Build → Preprocessing → Establish Component Connectivity. 

 

5.62 BMVC → VFS → Build → Preprocessing → Connect Beams to Columns and Walls.  

6.0 METHOD OF ANALYSIS CHECKS  

6.1 Method of Slab Analysis and Design   

6.11 
Method of Slab  

Analysis and Design 

Method 1 Method 2 

Conventional Codified  
BS8110 Coefficients Method 

Full Finite Element Method 
Design Method 

Slab Loads N/A 
Uniform, patch, line  

or point loads 

Slab Openings N/A Supported 

Irregular Floor Plates N/A Supported 

Flat Slabs N/A Supported 
 

 

6.2 Method of Application of Slab Loads onto Beams  

6.21 
Method of Load Application 

onto Beams 

Method 1 Method 2 

Yield Line Method Finite Element Method 

Slab Loads N/A N/A 

Slab Openings N/A N/A 

Irregular Floor Plates N/A N/A 
 

 

6.3 Method of Frame Analysis  

6.31 

Vertical Load Functional Framing and 
Lateral Load Stability Scheme 

Method of Frame Analysis 

Method 1 Method 2 

BA LTD2 

Beam-Column with Shear Wall Supported Partially Supported #C 

Beam-Column as Moment Frame Supported Partially Supported #C 

Flat Slab-Column with Shear Wall Supported #A Partially Supported #C 

Flat Slab-Column as Moment Frame Supported #B Partially Supported #C 

#A: Check flat slab / flat transfer slab analysis undertaken with Method 1 with lateral loads being resisted by shear walls. 
#B: Check flat slab / flat transfer slab analysis undertaken with Method 1 with lateral loads being resisted by flat slab / flat 
transfer slab and columns moment frames. 
#C: Note vertical load take down supported whilst lateral load take down not supported. 

 

6.32 

Method of Frame 
Analysis 

Transferred Beam/Slab  
on Transferred Wall/Column on Transfer Beam/Slab 

ULS and SLS Effects  
on Transferred 

ULS and SLS Effects  
on Transfer 
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Beam or  
Wall/Column 

Slab 

Beam 

Slab Beam or  
Wall/ 

Column 

Slab in 
Vicinity 

Beam 
Slab in 
Vicinity 

1 BA 
Supported 

#A, #B 
Supported 

#A, #B 
Supported 

#A, #B 
Supported 

#C 
Supported 

#D 
Supported 

#D 

2 LTD2 
Not 

Supported 
#A 

Not 
Supported 

Not 
Supported 

Supported 
#C 

Supported 
#D 

Supported 
#D 

#A: Check that the envelope effects of both Method 1 and Method 2 are used in the design of transferred beams, 
transferred slabs in vicinity, transferred slabs and transferred walls/columns, noting that Method 1 supports the effects of 
differential support settlement on superstructure beams, superstructure slabs in vicinity and superstructure slabs 
supported on walls/columns on transfer beams or transfer slabs or due to DAS of adjacent walls/columns. Note that the 
actual results (which can be predicted by a staged construction analysis) fall in between the effects produced by the two 
methods. The ULS load combinations inherently include the effects of differential (elastic, creep, shrinkage) axial shortening. 
Staged construction analysis may be performed to reduce the magnitude of the effects of differential (elastic, creep, shrinkage) 
axial shortening. 
#B: Check that Method 1 is adopted to cater for the effects of differential support settlement of transferred beams, 
transferred slabs in vicinity, transferred slabs and transferred walls/columns on transfer slabs. 
#C: Check that Method 2 is used to evaluate the effects on the transfer beams as Method 2 does not allow for the flexibility 
of the transfer beam resulting in larger action effects (forces, moments) on the transfer beam. 
#D: Check that Method 2 is used to evaluate the effect of walls/columns on transfer slabs and on slabs in the vicinity of 
walls/columns on transfer beams as Method 2 does not allow for the flexibility of the transfer slab / transfer beam 
resulting in larger action effects (forces, moments) on the transfer slab / slabs in the vicinity of transfer beams. 

6.33 

Item 

Method of Frame Analysis 

Method 1 Method 2 

BA LTD2 

Effect of Continuity on Beam  
Loading Tributary 

Supported Supported 

Effect of Flat Slabing in Beam-
Column Vertical Load 
Functional Framing 

Supported Supported 

Pattern Loading Not Supported Not Supported 

Effect of Slabs in Resisting 
Torsion of Beams 

Supported Supported 
 

 

7.0 SLAB ANALYSIS AND DESIGN CHECKS  

7.1 General  

7.11 In RC models, check sufficiency of rebar in orthogonal directions to fully mesh slab (ES). 
In PT models, check sufficiency of tendons (and rebar) in orthogonal directions to fully mesh slab (ES). 

 

7.2 Conventional Codified BS8110 Coefficients Method  

7.21 Manually check sufficiency of rebar based on conventional codified BS8110 coefficients method in RC models 
(ES). 

 

7.3 Full FE Method Design Method  

7.31 VFS → Select by Type → select Beam → Modify Item Properties → check Beam Tab uncracked stiffnesses (M11, 
M22, M33) to 1.00 and VFS → Select by Type → select Slab Region → Modify Item Properties → check Slab 
Region Tab uncracked stiffnesses (M11, M22) to 1.00. 
VFS → Select by Type → select Beam → Modify Item Properties → check Beam Tab cracked stiffnesses (M11, 
M22, M33) to 0.50 and VFS → Select by Type → select Slab Region → Modify Item Properties → check Slab 

Region Tab cracked stiffnesses (M11, M22) to 0.50. 
FEFA → select Uncracked Stiffness Modifier for Class 1 PT or Class 2 PT and Cracked Stiffness Modifier for RC or 
Class 3 PT (ES). 

 

7.32 Positive and Negative Moment Factors for FEFA Effects 

 
Positive 
Moment 
Factor 

Negative 
Moment 
Factor 

(Less conservative) elasto-plastic slab design  
(assuming conditions of cl.3.5.2.3 BS8110-1 satisfied) 

1.2 0.8 

(More conservative) elastic slab design  
(assuming conditions of cl.3.5.2.3 BS8110-1 satisfied) 

1.0 1.0 

(More conservative) elastic slab design with equivalent pattern loading 1.2 1.0 
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(assuming conditions of cl.3.5.2.3 BS8110-1 not satisfied) 
 

7.33 FEFA → VSS → RDS → Vibration → check animated deflections for modelling accuracy (ES).  

7.34 PT Tendon Modelling 
Build → Tendon → Create Tendon / Map Tendon Banded / Map Tendon Distributed → check tendons based on 
prestress force and eccentricity required for load balancing and prestress force for average precompression (ES). 
 
RC or PT Deflection Checks 
FEFA → VSS → RDS → Slab → Deformation → Z-Translation → check |TLS|=|DL+PT| deflections  

{[span/500 to span/350].C1, 20mm} (ES). 
FEFA → VSS → RDS → Slab → Deformation → Z-Translation → check SLS=DL+SDL+LL+PT deflections  

[span/250].C1 (ES). 
FEFA → VSS → RDS → Slab → Deformation → Z-Translation → check kC.(DL+SDL)+LL+kC,PT.PT deflections  

{[span/500 to span/350].C1, 20mm}, note the creep term also includes the total (elastic, creep, shrinkage) axial 
shortening of the one storey in question (ES). 
FEFA → VSS → RDS → Slab → Deformation → Z-Translation → check kC.(DL+SDL)+LL+kC,PT.PT deflections at 

façade beams  {[span/1000].C1, 20mm}, note the creep term also includes the total (elastic, creep, shrinkage) 

axial shortening of the one storey in question (ES). 
Note C1 = {0.8 for flanged beams, 10.0/span(m) for spans > 10.0m, 0.9 for flat slabs}. Note deflection criteria to 
cl.3.4.6.3 and cl.3.4.6.4 BS8110-1 and cl.3.2.1.1 and cl.3.2.1.2 BS8110-2. Note creep factor, kc calculated from 
equating 0.5.(1-0.4)DL+1.0SDL=kC.(DL+SDL) based on multiplying factor 0.5 for the total DL creep deflection 
component (as opposed to the instantaneous deflection component) to (1-0.4) for the remaining 60% 
component of DL creep deflection after 1 month (cl.7.3 BS8110-2), giving kC=[0.3DL+1.0SDL]/[DL+SDL]. Note 
likewise creep factor, kc,PT calculated as (1-0.5/KLT.KST).(1-0.4)=0.2625. 

 
In RC models, note if necessary, the simulation of the beneficial effect of additional reinforcement in controlling 
deflections can be made by factoring down the exhibited deflections by the ratio of the modified span / effective 
depth to the ratio of the basic span / effective depth (cantilever 7.0, simply supported 20.0, continuous 26.0) 
(ES). 

 

7.35 PT Tendon Modelling 
Build → Tendon → Create Tendon / Map Tendon Banded / Map Tendon Distributed → check tendons based on 
prestress force and eccentricity required for load balancing and prestress force for average precompression (ES). 
 
RC or PT Design Strip Support Lines, RC or PT Design Strip Tributaries and RC or PT Design Strip 
Design Sections Frequency 
VSS → Strips → Create Support Lines → check design strip support lines in X/Y directions (ES). 
VSS → select Support Lines → Modify Item Properties → check Support Line Tab direction, criteria, rebar layer, 
maximum number of design sections per span to 10, distance of design section from face of column to 50mm, 
selecting display design sections and display results (ES). 
VSS → Strips → Create Splitters → check design strip support lines splitters spanning between defined support 
lines for voids (e.g. lift and staircase) (ES). 
VSS → RPT-G → Design Plans → Support Lines X/Y-Directions → check design strip support lines in X/Y 
directions (ES). 
VSS → Strips / FEM → Generate Design Sections Automatically → Regenerate Tributaries → check design strip 
tributaries in X/Y directions and design strip design sections frequency for RC (column and middle design strip) 
or PT (full tributary width design strip) (ES). 
VSS → RPT-G → Design Plans → Design Strips X/Y-Directions → check design strip tributaries in X/Y directions 
(ES). 
 
FE Analysis Method RC Analysis and Design 
FEFA → VSS → check RC analysis and design in X/Y directions (ES) → RDS → Slab  

 

LPB 

LSB 

LFR 

LS 
LS : slab deflection check 
 

LSB : secondary beam 
deflection check 
 

LPB : primary beam deflection 
check 
 

LFR : frame (column to 
column) deflection check 

 

LPB 

LSB 

LFR 

LS 



 

 

FEM Design Verification Checklist for ADAPT-Builder 2017 (Summary) 
 
 

 

© Maverick United | 4 July 2019   P a g e  | 14

   

ITEM CONTENT  

→ Actions (Contour Map) → |Mxx|+|Mxy| and |Myy|+|Mxy| → check ULS bending effects MULS,E/E, note w.o./w. 
the differential (elastic, creep, shrinkage) axial shortening of adjacent supports. 
→ manually check ULS shear effects VULS,E/E, note w.o./w. the differential (elastic, creep, shrinkage) axial 
shortening of adjacent supports. 
 
RC Design Strip Design Sections FE Analysis Method Integration of Effects Analysis and RC Design 
Strip Design Sections Design 
FEFA → VSS → FEM → Design the “Design Section(s)” → Investigate (does not add rebar even if required) / 
Design (does add rebar if required) → check design strip design sections RC analysis and design in X/Y 
directions (ES) → RDS → Design Sections  
→ Actions → Bending → check ULS bending effects MULS,E/E based on 1.4 x tributary width x (15.0-25.0kPa) x 
L2/12, note w.o./w. the differential (elastic, creep, shrinkage) axial shortening of adjacent supports. 
→ Actions → Shear → check ULS shear effects VULS,E/E based on 1.4 x tributary width x (15.0-25.0kPa) x L/2, 
note w.o./w. the differential (elastic, creep, shrinkage) axial shortening of adjacent supports. 
→ manually check rebar areas (to resist ULS bending) required {As(d)xx, As(d)yy}, noting minimum steel. 
→ manually check ULS shear capacity, Vu is greater than ULS shear effects VULS,E/E together with the 
associated required shear links Asv,req/S. 
FEFA → VSS → FEM → Generate Rebar Drawing → check rebar (to resist ULS bending) required in X/Y 
directions (ES). 
 
FE Analysis Method PT Analysis and Design 
FEFA → VSS → check PT analysis and design in X/Y directions (ES) → RDS → Slab  
→ Actions (Contour Map) → |Mxx|+|Mxy| and |Myy|+|Mxy| → check TLS/SLS bending effects 
MTLS/SLS,E/E+MTLS/SLS,E/L are minimal. 
→ Actions (Contour Map) → |Mxx|+|Mxy| and |Myy|+|Mxy| → check ULS bending effects MULS,E/E+MULS,S/E, note 
w.o./w. the differential (elastic, creep, shrinkage) axial shortening of adjacent supports. 
Note by convention, +ve bending moment is sagging and –ve bending moment is hogging (consistent with 
ADAPT-Builder). 
→ Stress (Contour Map) → Mid-Depth Along XX/YY → check TLS/SLS average precompression 0.7-
2.5N/mm2 for slab and 2.5-4.5N/mm2 for beam. 

→ Stress (Contour Map) → Top Fibre Along XX/YY → check TLS top stress f’min,t ≤ f’t ≤ f’max,t  
 BM:| -1.0 ≤ f’t ≤ 0.50fci [CL1] | -0.36√fci ≤ f’t ≤ 0.50fci [CL2] | -0.25fci ≤ f’t ≤ 0.50fci [CL3] | 

   FS:| -1.0 ≤ f’t ≤ 0.24fci [CL1] | -0.36√fci ≤ f’t ≤ 0.24fci [CL2] | -0.45√fci ≤ f’t ≤ 0.24fci [CL3] | 

→ Stress (Contour Map) → Bottom Fibre Along XX/YY → check TLS bottom stress f’min,b ≤ f’b ≤ f’max,b  
 BM:| -1.0 ≤ f’b ≤ 0.50fci [CL1] | -0.36√fci ≤ f’b ≤ 0.50fci [CL2] | -0.25fci ≤ f’b ≤ 0.50fci [CL3] | 

   FS:| -1.0 ≤ f’b ≤ 0.33fci [CL1] | -0.36√fci ≤ f’b ≤ 0.33fci [CL2] | -0.45√fci ≤ f’b ≤ 0.33fci [CL3] | 

→ Stress (Contour Map) → Top Fibre Along XX/YY → check SLS top stress fmin,t ≤ ft ≤ fmax,t  
 BM:| -0.0 ≤ ft ≤ 0.33fcu [CL1] | -0.36√fcu ≤ ft ≤ 0.33fcu [CL2] | -<.......> ≤ ft ≤ 0.33fcu [CL3] | 

   FS:| -0.0 ≤ ft ≤ 0.33fcu [CL1] | -0.36√fcu ≤ ft ≤ 0.33fcu [CL2] | -0.45√fcu ≤ ft ≤ 0.33fcu [CL3] | 

 Note -<.......> = MAX {-0.25fcu, (0.7-1.1).(-0.58√fcu to -0.82√fcu)-4N/mm2/1.0%}. 

→ Stress (Contour Map) → Bottom Fibre Along XX/YY → check SLS bottom stress fmin,b ≤ fb ≤ fmax,b  
 BM:| -0.0 ≤ fb ≤ 0.40fcu [CL1] | -0.36√fcu ≤ fb ≤ 0.40fcu [CL2] | -<.......> ≤ fb ≤ 0.40fcu [CL3] | 

   FS:| -0.0 ≤ fb ≤ 0.24fcu [CL1] | -0.36√fcu ≤ fb ≤ 0.24fcu [CL2] | -0.45√fcu ≤ fb ≤ 0.24fcu [CL3] | 

 Note -<.......> = MAX {-0.25fcu, (0.7-1.1).(-0.58√fcu to -0.82√fcu)-4N/mm2/1.0%}. 
Note by convention, +ve stress is compressive and –ve stress is tensile (inconsistent with ADAPT-Builder). 
 
PT Design Strip Design Sections FE Analysis Method Integration of Effects Analysis and PT Design 
Strip Design Sections Design 
FEFA → VSS → FEM → Design the “Design Section(s)” → Investigate (does not add rebar even if required) / 
Design (does add rebar if required) → check design strip design sections PT analysis and design in X/Y 
directions (ES) → RDS → Design Sections  

→ Deformation → Z-Translation → check |TLS|=|DL+PT| deflections  {[span/500 to span/350].C1, 20mm}. 

→ Deformation → Z-Translation → check SLS=DL+SDL+LL+PT deflections  [span/250].C1. 

→ Deformation → Z-Translation → check kC.(DL+SDL)+LL+kC,PT.PT deflections  {[span/500 to span/350].C1, 

20mm}, note the creep term also includes the total (elastic, creep, shrinkage) axial shortening of the one storey 
in question. 
→ Deformation → Z-Translation → check kC.(DL+SDL)+LL+kC,PT.PT deflections at façade beams  

{[span/1000].C1, 20mm}, note the creep term also includes the total (elastic, creep, shrinkage) axial shortening 
of the one storey in question. 
Note C1 = {0.8 for flanged beams, 10.0/span(m) for spans > 10.0m, 0.9 for flat slabs}. Note deflection criteria to 
cl.3.4.6.3 and cl.3.4.6.4 BS8110-1 and cl.3.2.1.1 and cl.3.2.1.2 BS8110-2. Note creep factor, kc calculated from 
equating 0.5.(1-0.4)DL+1.0SDL=kC.(DL+SDL) based on multiplying factor 0.5 for the total DL creep deflection 
component (as opposed to the instantaneous deflection component) to (1-0.4) for the remaining 60% 
component of DL creep deflection after 1 month (cl.7.3 BS8110-2), giving kC=[0.3DL+1.0SDL]/[DL+SDL]. Note 
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likewise creep factor, kc,PT calculated as (1-0.5/KLT.KST).(1-0.4)=0.2625. 
→ Balanced Loading → check percentage of DL+SDL load balancing is approximately 70-100%. 
→ Actions → Bending → check TLS/SLS bending effects MTLS/SLS,E/E+MTLS/SLS,E/L are minimal. 
→ Actions → Bending → check ULS bending effects MULS,E/E+MULS,S/E based on 1.4 x tributary width x (15.0-

25.0kPa) x L2/12 and hyperstatic effects, note w.o./w. the differential (elastic, creep, shrinkage) axial 
shortening of adjacent supports. 
Note by convention, +ve bending moment is sagging and –ve bending moment is hogging (consistent with 
ADAPT-Builder). 
→ Actions → Shear → check TLS/SLS shear effects VTLS/SLS,E/E+VTLS/SLS,E/L are minimal. 
→ Actions → Shear → check ULS shear effects VULS,E/E+VULS,S/E based on 1.4 x tributary width x (15.0-25.0kPa) 
x L/2 and hyperstatic effects, note w.o./w. the differential (elastic, creep, shrinkage) axial shortening of 
adjacent supports. 
Note an arbitrary sign convention adopted for shear force (inconsistent with ADAPT-Builder). 
→ Stresses → Average (Precompression) → check TLS/SLS average precompression 0.7-2.5N/mm2 for slab 
and 2.5-4.5N/mm2 for beam. 

→ Stresses → Top → check TLS top stress f’min,t ≤ f’t ≤ f’max,t  
 BM:| -1.0 ≤ f’t ≤ 0.50fci [CL1] | -0.36√fci ≤ f’t ≤ 0.50fci [CL2] | -0.25fci ≤ f’t ≤ 0.50fci [CL3] | 

   FS:| -1.0 ≤ f’t ≤ 0.24fci [CL1] | -0.36√fci ≤ f’t ≤ 0.24fci [CL2] | -0.45√fci ≤ f’t ≤ 0.24fci [CL3] | 

→ Stresses → Bottom → check TLS bottom stress f’min,b ≤ f’b ≤ f’max,b  
 BM:| -1.0 ≤ f’b ≤ 0.50fci [CL1] | -0.36√fci ≤ f’b ≤ 0.50fci [CL2] | -0.25fci ≤ f’b ≤ 0.50fci [CL3] | 

   FS:| -1.0 ≤ f’b ≤ 0.33fci [CL1] | -0.36√fci ≤ f’b ≤ 0.33fci [CL2] | -0.45√fci ≤ f’b ≤ 0.33fci [CL3] | 

→ Stresses → Top → check SLS top stress fmin,t ≤ ft ≤ fmax,t  
 BM:| -0.0 ≤ ft ≤ 0.33fcu [CL1] | -0.36√fcu ≤ ft ≤ 0.33fcu [CL2] | -<.......> ≤ ft ≤ 0.33fcu [CL3] | 

   FS:| -0.0 ≤ ft ≤ 0.33fcu [CL1] | -0.36√fcu ≤ ft ≤ 0.33fcu [CL2] | -0.45√fcu ≤ ft ≤ 0.33fcu [CL3] | 

 Note -<.......> = MAX {-0.25fcu, (0.7-1.1).(-0.58√fcu to -0.82√fcu)-4N/mm2/1.0%}. 

→ Stresses → Bottom → check SLS bottom stress fmin,b ≤ fb ≤ fmax,b  
 BM:| -0.0 ≤ fb ≤ 0.40fcu [CL1] | -0.36√fcu ≤ fb ≤ 0.40fcu [CL2] | -<.......> ≤ fb ≤ 0.40fcu [CL3] | 

   FS:| -0.0 ≤ fb ≤ 0.24fcu [CL1] | -0.36√fcu ≤ fb ≤ 0.24fcu [CL2] | -0.45√fcu ≤ fb ≤ 0.24fcu [CL3] | 

 Note -<.......> = MAX {-0.25fcu, (0.7-1.1).(-0.58√fcu to -0.82√fcu)-4N/mm2/1.0%}. 
Note by convention, +ve stress is compressive and –ve stress is tensile (inconsistent with ADAPT-Builder). 
→ manually check rebar areas (to resist SLS tensile stress) required {As(d)xx, As(d)yy}, noting minimum 
steel. 
→ Investigation → Moment Capacity with Demand → check ULS moment capacity, Mu is greater than ULS 
bending effects MULS,E/E+MULS,S/E. 
→ manually check ULS shear capacity, Vu is greater than ULS shear effects VULS,E/E+VULS,S/E together with the 
associated required shear links Asv,req/S. 
FEFA → VSS → FEM → Generate Rebar Drawing → check rebar (to resist SLS tensile stress) required in 
X/Y directions (ES). 
 
RC or PT Method of Slab Detailing 

RC or PT Method of Slab Detailing 

Method 1:  
Automatic 
Specification of 
Reinforcement 
Bars 

Automatic specification of (top and bottom) reinforcement bars based on slab 
rebar setting Criteria → General → One-Way or Two-Way Slab → Preferred 
Reinforcement Size and Material → Preferred Steel Bar Size T16 (T) and T10 (B) and 
Crack Control Bar Spacing 300mm. Note in this method, only the 1/3rd span hogging 
regions will be automatically reinforced, manual addition required for top steel 
throughout. 

Method 2:  
Semi-Automatic 
Specification of 
Reinforcement 
Mesh / Bars 

Automatic specification of (top) reinforcement mesh / bars based on slab rebar 
setting Criteria → General → One-Way or Two-Way Slab → Preferred Reinforcement 
Size and Material → Preferred Steel Bar Size T16 (T) and T10 (B) and Crack Control 

Bar Spacing 300mm and subsequent manual equivalent mesh substitution (where 
possible). Note in this method, only the 1/3rd span hogging regions will be 
automatically reinforced, manual addition required for top steel throughout. Manual 
specification of (bottom) reinforcement mesh / bars based on FEFA rebar areas 
required {As(d)xx, As(d)yy} for slab panels (Method 3). 

Method 3:  
Manual 
Specification of 
Reinforcement 
Mesh / Bars 

Manual specification of (top) reinforcement mesh / bars based on FEFA rebar 
areas required {As(d)xx, As(d)yy} for slab panels. Note in this method, since it is a 
manual method, either only the 1/3rd span hogging regions may be reinforced or 
alternatively top steel may be provided throughout. Manual specification of 
(bottom) reinforcement mesh / bars based on FEFA rebar areas required {As(d)xx, 
As(d)yy} for slab panels. 

 
RC or PT Analysis and Design Summary Report 



 

 

FEM Design Verification Checklist for ADAPT-Builder 2017 (Summary) 
 
 

 

© Maverick United | 4 July 2019   P a g e  | 16

   

ITEM CONTENT  

VSS → RPT-T → Design Section Data → Design Section Forces Tabular Report → check design strip design 
sections forces (ES). 
VSS → RPT-T → Design Section Data → Design Section Rebar Tabular Report → check design strip design 
sections rebar (ES). 
VSS → RPT-T → Design Section Data → Design Section Moment Capacities → check design strip design sections 
moment capacities (ES). 
VSS → RPT-T → Design Section Data → Design Section Dimension → check design strip design sections 
dimensions (ES). 
VSS → RPT-T → Design Section Data → Design Section Geometry → check design strip design sections 
geometry (ES). 
VSS → RPT-G → Tendon/Rebar Plan → check tendon and rebar plans (ES). 

7.36 Manually check ULS shear stresses and shear design at beam/wall supports of heavily loaded slabs (ES).  

7.37 VSS → FEM → Punching Shear Check → check ULS punching shear at wall/column supports of flat slabs (ES). 
VSS → RPT-T → Punching Shear Design → Punching Shear Stress Check Result → check punching shear stress 
results (ES). 
VSS → RPT-T → Punching Shear Design → Punching Shear Stress Check Parameters → check punching shear 
stress parameters (ES). 
VSS → RPT-T → Punching Shear Design → Punching Shear Reinforcement → check punching shear 
reinforcement (ES). 

 

8.0 BEAM AND WALL/COLUMN ANALYSIS AND DESIGN CHECKS  

8.1 Building Analysis Method  

8.11 BA → VSS → RDS → Vibration check skeletal FE model correctly discretises the sectional model by checking 
animated deflections for modelling accuracy ensuring that all primary beams do frame onto their supporting 
columns (also displaying the primary beam ULS bending moments for clarity by selecting BA → VSS → RDS → 
Beam → Actions (Diagram) → Moment About zz) (ES). 

 

8.12 BA → VSS → RDS → Beam → Deformation → Z-Translation → check |TLS|=|DL+PT| deflections  {[span/500 

to span/350].C1, 20mm} (ES). 
BA → VSS → RDS → Beam → Deformation → Z-Translation → check SLS=DL+SDL+LL+PT deflections  

[span/250].C1 (ES). 
BA → VSS → RDS → Beam → Deformation → Z-Translation → check kC.(DL+SDL)+LL+PT deflections  

{[span/500 to span/350].C1, 20mm} (ES). 
BA → VSS → RDS → Beam → Deformation → Z-Translation → check kC.(DL+SDL)+LL+PT deflections at façade 

beams  {[span/1000].C1, 20mm} (ES). 

Note C1 = {0.8 for flanged beams, 10.0/span(m) for spans > 10.0m, 0.9 for flat slabs}. Note deflection criteria to 
cl.3.4.6.3 and cl.3.4.6.4 BS8110-1 and cl.3.2.1.1 and cl.3.2.1.2 BS8110-2. Note creep factor, kc calculated from 
equating 0.5.(1-0.4)DL+1.0SDL=kC.(DL+SDL) based on multiplying factor 0.5 for the total DL creep deflection 
component (as opposed to the instantaneous deflection component) to (1-0.4) for the remaining 60% 
component of DL creep deflection after 1 month (cl.7.3 BS8110-2), giving kC=[0.3DL+1.0SDL]/[DL+SDL]. 

 

8.13 BA → VSS → RDS → Beam → Actions (Diagram) → check magnitude and shape of ULS effects (axial forces, 
shear forces, bending moments, torsional moments) (ES). 

 

8.14 BA → VFS → RDS → Wall/Column → Actions (Diagram) → perform the Moment Ratio Check to comprehend 
the building primary lateral stability elements by both: - 
(i) comparing the relative magnitude of the coupled shear wall / moment frame / outrigger frame / tube 

(shear mode) equivalent global bending moment (back-calculated by multiplying the push-pull axial 
forces of the walls/columns at the frame extremity with the frame extremity lever arm, noting that the 
effectiveness of the coupling beams / moment beams / outrigger beams / (framed) tube web spandrel 
beams in contributing to the base moment resisting lateral stability is measured from the existence of 
significant push-pull axial forces in the walls/columns at the frame extremity, from the existence of 
significant local zig-zag bending moments in the walls/columns (except outrigger columns and tube flange 
columns) or from the existence of significant zig-zag bending moments in the coupling beams / moment 
beams / outrigger beams / (framed) tube web spandrel beams themselves) with the magnitude of the 
shear wall (bending mode) cumulative bending moment (exhibited as cumulative bending moments 
in the shear walls or as push-pull axial forces within the flanges of flanged shear walls) from lateral loads 
only (noting that the summation of which shall match the stability base moment) (ES), and 

(ii) comparing the relative magnitude of the summation of the coupled shear wall / moment frame / 
outrigger frame (except outrigger columns) / (framed) tube (except tube flange columns) wall/column 
(shear mode) shear forces (which cause the local zig-zag bending moments in the walls/columns, 
noting that the effectiveness of the coupling beams / moment beams / outrigger beams / (framed) tube 
web spandrel beams in contributing to the base shear resisting lateral stability is measured from the 
existence of significant shear forces in the walls/columns (except outrigger columns and tube flange 
columns) or from the existence of significant shear forces in the coupling beams / moment beams / 
outrigger beams / (framed) tube web spandrel beams themselves) with the magnitude of the shear wall 
(bending mode) cumulative shear force from lateral loads only (noting that the summation of which 
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shall match the stability base shear) (ES). 
Note that the effect to the stability base moment and stability base shear of a transfer floor (defined as 
a horizontal level at which the more extensive vertical elements on plan become discontinuous on elevation 
ensuing in less extensive vertical elements on plan) is firstly, the resolution of the stability base moment at the 
transfer level to constant push-pull axial forces in the walls/columns at the transfer frame extremity (somewhat 
akin to the effect of an outrigger) below the transfer level and secondly, the redistribution of stability base 
shear to different stability elements. 
 
 
 

 

                    =             +  
 
 
    
               Stability Base       Stability Base 
              Moment (MNm)      Shear (MN) 

8.15 BA → VSS → RDS → Wall/Column → Deformation → Z-Translation → and FEFA → VSS → RDS → Wall/Column 
→ Deformation → Z-Translation → check differential beam support SLS settlement (i.e. SLS settlement at 
the wall/column points) due to DAS of adjacent walls/columns (as a result of non-uniform column sections areas 
or non-uniform axial loading due to say differing building heights) and/or due to uneven flexibility of transfer 
beams below  span/400 (ES). Note that significant differential beam support (i.e. wall/column point) settlement 

is also characterised by a significant lateral deflection (sway) of the building due to DL+SDL+LL+PT alone to the 
side undergoing greater elastic shortening or to the side supported by walls/columns on more flexible transfer 
beams (thus check for lateral movement of the floor plate on plan due to DL+SDL+LL+PT alone is ≤ span/500). 
The SLS load combination inherently includes the effects of differential (elastic, creep, shrinkage) axial 
shortening. Staged construction analysis may be performed to reduce the magnitude of the effects of differential 
(elastic, creep, shrinkage) axial shortening. Finally, significant differential beam support (i.e. wall/column point) 
settlement is also characterised by large discrepancies in the load take down, transfer beam bending 
moments and the higher levels beam bending moments predicted between the BA and LTD2 methods of 
frame analysis. The ULS load combinations inherently include the effects of differential (elastic, creep, shrinkage) 
axial shortening. Staged construction analysis may be performed to reduce the magnitude of the effects of 
differential (elastic, creep, shrinkage) axial shortening. Since it is difficult to reduce elastic shortening 
significantly, a better strategy is to limit the DAS by designing all walls/columns to the same axial stress level, 
maintain long clear spans between different structural types, i.e. between lightly-loaded cores and shear walls on 
the one hand and heavily loaded columns on the other or introduce settlement joints / pour strips between areas 
subject to large DAS (ES). 

 

8.16 Manually check that the bending moment design, ultimate shear force (ultimate shear stress) check and shear 
force design of beams with incoming offset beams (i.e. secondary beams that frame into the beam in question 
within the footprint of the wall/column) with a physical width that protrudes beyond the wall/column footprint is 
sufficiently enhanced (ES). 

 

8.17 Manually check beams (especially heavily loaded beams / transfer beams) with widths larger than the supporting 
wall/column width for ultimate shear and design shear within a beam width equal to the supporting wall/column 
width, notwithstanding the reverse analogy to multi column footing foundation shear design where the full width 
of the footing beam contributes to the ultimate and design shear capacity. These beams need also be manually 
checked for ULS punching shear (ES). 

 

8.18 Manually check ULS shear stresses and shear design at transferred walls on transfer beams.  

8.19 Manually check ULS punching shear at transferred walls/columns on transfer beams.  

8.2 Load Take Down Method  

8.21 VSS → Select by Type → select Beam → Modify Item Properties → check (transfer) Beam Tab uncracked 

stiffnesses (M11, M22, M33) to (2/3rd).(1.00)0.66 and VSS → Select by Type → select Slab Region → Modify 

Item Properties → check (transfer) Slab Region Tab uncracked stiffnesses (M11, M22) to (2/3rd).(1.00)0.66, 

note the further 2/3rd reduction factor applied to simulate the additional deflection due to creep to storage 
loading instead of normal loading (i.e. creep coefficient, =2 for storage loading instead of =1 for normal 

loading). 
VSS → Select by Type → select Beam → Modify Item Properties → check (transfer) Beam Tab cracked 

stiffnesses (M11, M22, M33) to (2/3rd).(0.50)0.32 and VSS → Select by Type → select Slab Region → Modify 

Item Properties → check (transfer) Slab Region Tab cracked stiffnesses (M11, M22) to (2/3rd).(0.50)0.32, note 

the further 2/3rd reduction factor applied to simulate the additional deflection due to creep to storage loading 
instead of normal loading (i.e. creep coefficient, =2 for storage loading instead of =1 for normal loading). 
LTD2 → select Uncracked Stiffness Modifier for Class 1 PT or Class 2 PT and Cracked Stiffness Modifier for RC or 
Class 3 PT. 

 

8.22 PT Tendon Modelling  
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ITEM CONTENT  

Build → Tendon → Create Tendon / Map Tendon Banded / Map Tendon Distributed → check tendons based on 
prestress force and eccentricity required for load balancing and prestress force for average precompression. 
 
RC or PT Deflection Checks 

LTD2 → VSS → RDS → Slab → Deformation → Z-Translation → check |TLS|=|DL+PT| deflections  {[span/500 

to span/350].C1, 20mm}. 
LTD2 → VSS → RDS → Slab → Deformation → Z-Translation → check SLS=DL+SDL+LL+PT deflections  

[span/250].C1. 
LTD2 → VSS → RDS → Slab → Deformation → Z-Translation → check kC.(DL+SDL)+LL+kC,PT.PT deflections  

{[span/500 to span/350].C1, 20mm}, note the creep term also includes the total (elastic, creep, shrinkage) axial 
shortening of the one storey in question. 
LTD2 → VSS → RDS → Slab → Deformation → Z-Translation → check kC.(DL+SDL)+LL+kC,PT.PT deflections at 

façade beams  {[span/1000].C1, 20mm}, note the creep term also includes the total (elastic, creep, shrinkage) 

axial shortening of the one storey in question. 
Note deflections above refer to deflections of all transfer slabs and slabs in the vicinity of transfer beams.  
Note C1 = {0.8 for flanged beams, 10.0/span(m) for spans > 10.0m, 0.9 for flat slabs}. Note deflection criteria to 
cl.3.4.6.3 and cl.3.4.6.4 BS8110-1 and cl.3.2.1.1 and cl.3.2.1.2 BS8110-2. Note creep factor, kc calculated from 
equating (1-0.32).(1-0.4)DL+1.0SDL=kC.(DL+SDL) based on multiplying factor (1-0.32) for the total DL creep 
deflection component (as opposed to the instantaneous deflection component) to (1-0.4) for the remaining 60% 
component of DL creep deflection after 1 month (cl.7.3 BS8110-2), giving kC=[0.4DL+1.0SDL]/[DL+SDL]. Note 
likewise creep factor, kc,PT calculated as (1-0.32/KLT.KST).(1-0.4)=0.375. 

 
In RC models, note if necessary, the simulation of the beneficial effect of additional reinforcement in controlling 
deflections can be made by factoring down the exhibited deflections by the ratio of the modified span / effective 
depth to the ratio of the basic span / effective depth (cantilever 7.0, simply supported 20.0, continuous 26.0). 

8.23 Note here that in the following subsection, slab refers to transfer slab and slabs in the vicinity of transfer beams 
and beam refers to transfer beam. 
 
PT Tendon Modelling 
Build → Tendon → Create Tendon / Map Tendon Banded / Map Tendon Distributed → check tendons based on 
prestress force and eccentricity required for load balancing and prestress force for average precompression. 
 
RC or PT Design Strip Support Lines, RC or PT Design Strip Tributaries and RC or PT Design Strip 
Design Sections Frequency 
VSS → Strips → Create Support Lines → check design strip support lines in X/Y directions. 
VSS → select Support Lines → Modify Item Properties → check Support Line Tab direction, criteria, rebar layer, 
maximum number of design sections per span to 10, distance of design section from face of column to 50mm, 
selecting display design sections and display results. 
VSS → Strips → Create Splitters → check design strip support lines splitters spanning between defined support 

lines for voids (e.g. lift and staircase). 
VSS → RPT-G → Design Plans → Support Lines X/Y-Directions → check design strip support lines in X/Y 
directions. 
VSS → Strips / FEM → Generate Design Sections Automatically → Regenerate Tributaries → check design strip 
tributaries in X/Y directions and design strip design sections frequency for RC (column and middle design strip) 
or PT (full tributary width design strip). 
VSS → RPT-G → Design Plans → Design Strips X/Y-Directions → check design strip tributaries in X/Y directions. 
 
FE Analysis Method RC Analysis and Design 
LTD2 → VSS → check RC analysis and design in X/Y directions → RDS → Slab  
→ Actions (Contour Map) → |Mxx|+|Mxy| and |Myy|+|Mxy| → check ULS bending effects MULS,E/E, note w.o./w. 
the differential (elastic, creep, shrinkage) axial shortening of adjacent supports. 

 

LPB 

LSB 

LFR 

LS 
LS : slab deflection check 
 

LSB : secondary beam 
deflection check 
 

LPB : primary beam deflection 
check 
 

LFR : frame (column to 
column) deflection check 

 

LPB 

LSB 

LFR 

LS 
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ITEM CONTENT  

→ manually check ULS shear effects VULS,E/E, note w.o./w. the differential (elastic, creep, shrinkage) axial 
shortening of adjacent supports. 
 
RC Design Strip Design Sections FE Analysis Method Integration of Effects Analysis and RC Design 
Strip Design Sections Design 
LTD2 → VSS → FEM → Design the “Design Section(s)” → Investigate (does not add rebar even if required) / 
Design (does add rebar if required) → check design strip design sections RC analysis and design in X/Y 
directions → RDS → Design Sections 
→ Actions → Bending → check ULS bending effects MULS,E/E based on 1.4 x tributary width x (15.0-25.0kPa) x 
L2/12, note w.o./w. the differential (elastic, creep, shrinkage) axial shortening of adjacent supports. 
→ Actions → Shear → check ULS shear effects VULS,E/E based on 1.4 x tributary width x (15.0-25.0kPa) x L/2, 
note w.o./w. the differential (elastic, creep, shrinkage) axial shortening of adjacent supports. 
→ manually check rebar areas (to resist ULS bending) required {As(d)xx, As(d)yy}, noting minimum steel. 
→ manually check ULS shear capacity, Vu is greater than ULS shear effects VULS,E/E together with the 
associated required shear links Asv,req/S. 
LTD2 → VSS → FEM → Generate Rebar Drawing → check rebar (to resist ULS bending) required in X/Y 
directions. 
 
FE Analysis Method PT Analysis and Design 
LTD2 → VSS → check PT analysis and design in X/Y directions → RDS → Slab  
→ Actions (Contour Map) → |Mxx|+|Mxy| and |Myy|+|Mxy| → check TLS/SLS bending effects 
MTLS/SLS,E/E+MTLS/SLS,E/L are minimal. 
→ Actions (Contour Map) → |Mxx|+|Mxy| and |Myy|+|Mxy| → check ULS bending effects MULS,E/E+MULS,S/E, note 
w.o./w. the differential (elastic, creep, shrinkage) axial shortening of adjacent supports. 
Note by convention, +ve bending moment is sagging and –ve bending moment is hogging (consistent with 
ADAPT-Builder). 
→ Stress (Contour Map) → Mid-Depth Along XX/YY → check TLS/SLS average precompression 0.7-
2.5N/mm2 for slab and 2.5-4.5N/mm2 for beam. 

→ Stress (Contour Map) → Top Fibre Along XX/YY → check TLS top stress f’min,t ≤ f’t ≤ f’max,t  
 BM:| -1.0 ≤ f’t ≤ 0.50fci [CL1] | -0.36√fci ≤ f’t ≤ 0.50fci [CL2] | -0.25fci ≤ f’t ≤ 0.50fci [CL3] | 

   FS:| -1.0 ≤ f’t ≤ 0.24fci [CL1] | -0.36√fci ≤ f’t ≤ 0.24fci [CL2] | -0.45√fci ≤ f’t ≤ 0.24fci [CL3] | 

→ Stress (Contour Map) → Bottom Fibre Along XX/YY → check TLS bottom stress f’min,b ≤ f’b ≤ f’max,b  
 BM:| -1.0 ≤ f’b ≤ 0.50fci [CL1] | -0.36√fci ≤ f’b ≤ 0.50fci [CL2] | -0.25fci ≤ f’b ≤ 0.50fci [CL3] | 

   FS:| -1.0 ≤ f’b ≤ 0.33fci [CL1] | -0.36√fci ≤ f’b ≤ 0.33fci [CL2] | -0.45√fci ≤ f’b ≤ 0.33fci [CL3] | 

→ Stress (Contour Map) → Top Fibre Along XX/YY → check SLS top stress fmin,t ≤ ft ≤ fmax,t  
 BM:| -0.0 ≤ ft ≤ 0.33fcu [CL1] | -0.36√fcu ≤ ft ≤ 0.33fcu [CL2] | -<.......> ≤ ft ≤ 0.33fcu [CL3] | 

   FS:| -0.0 ≤ ft ≤ 0.33fcu [CL1] | -0.36√fcu ≤ ft ≤ 0.33fcu [CL2] | -0.45√fcu ≤ ft ≤ 0.33fcu [CL3] | 

 Note -<.......> = MAX {-0.25fcu, (0.7-1.1).(-0.58√fcu to -0.82√fcu)-4N/mm2/1.0%}. 

→ Stress (Contour Map) → Bottom Fibre Along XX/YY → check SLS bottom stress fmin,b ≤ fb ≤ fmax,b  
 BM:| -0.0 ≤ fb ≤ 0.40fcu [CL1] | -0.36√fcu ≤ fb ≤ 0.40fcu [CL2] | -<.......> ≤ fb ≤ 0.40fcu [CL3] | 

   FS:| -0.0 ≤ fb ≤ 0.24fcu [CL1] | -0.36√fcu ≤ fb ≤ 0.24fcu [CL2] | -0.45√fcu ≤ fb ≤ 0.24fcu [CL3] | 

 Note -<.......> = MAX {-0.25fcu, (0.7-1.1).(-0.58√fcu to -0.82√fcu)-4N/mm2/1.0%}. 
Note by convention, +ve stress is compressive and –ve stress is tensile (inconsistent with ADAPT-Builder). 
 
PT Design Strip Design Sections FE Analysis Method Integration of Effects Analysis and PT Design 
Strip Design Sections Design 
LTD2 → VSS → FEM → Design the “Design Section(s)” → Investigate (does not add rebar even if required) / 
Design (does add rebar if required) → check design strip design sections PT analysis and design in X/Y 
directions → RDS → Design Sections 

→ Deformation → Z-Translation → check |TLS|=|DL+PT| deflections  {[span/500 to span/350].C1, 20mm}. 

→ Deformation → Z-Translation → check SLS=DL+SDL+LL+PT deflections  [span/250].C1. 

→ Deformation → Z-Translation → check kC.(DL+SDL)+LL+kC,PT.PT deflections  {[span/500 to span/350].C1, 

20mm}, note the creep term also includes the total (elastic, creep, shrinkage) axial shortening of the one storey 
in question. 
→ Deformation → Z-Translation → check kC.(DL+SDL)+LL+kC,PT.PT deflections at façade beams  

{[span/1000].C1, 20mm}, note the creep term also includes the total (elastic, creep, shrinkage) axial shortening 
of the one storey in question. 
Note C1 = {0.8 for flanged beams, 10.0/span(m) for spans > 10.0m, 0.9 for flat slabs}. Note deflection criteria to 
cl.3.4.6.3 and cl.3.4.6.4 BS8110-1 and cl.3.2.1.1 and cl.3.2.1.2 BS8110-2. Note creep factor, kc calculated from 
equating 0.5.(1-0.4)DL+1.0SDL=kC.(DL+SDL) based on multiplying factor 0.5 for the total DL creep deflection 
component (as opposed to the instantaneous deflection component) to (1-0.4) for the remaining 60% 
component of DL creep deflection after 1 month (cl.7.3 BS8110-2), giving kC=[0.3DL+1.0SDL]/[DL+SDL]. Note 
likewise creep factor, kc,PT calculated as (1-0.32/KLT.KST).(1-0.4)=0.375. 
→ Balanced Loading → check percentage of DL+SDL load balancing is approximately 70-100%. 
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ITEM CONTENT  

→ Actions → Bending → check TLS/SLS bending effects MTLS/SLS,E/E+MTLS/SLS,E/L are minimal. 
→ Actions → Bending → check ULS bending effects MULS,E/E+MULS,S/E based on 1.4 x tributary width x (15.0-
25.0kPa) x L2/12 and hyperstatic effects, note w.o./w. the differential (elastic, creep, shrinkage) axial 
shortening of adjacent supports. 
Note by convention, +ve bending moment is sagging and –ve bending moment is hogging (consistent with 
ProtaStructure). 
→ Actions → Shear → check TLS/SLS shear effects VTLS/SLS,E/E+VTLS/SLS,E/L are minimal. 
→ Actions → Shear → check ULS shear effects VULS,E/E+VULS,S/E based on 1.4 x tributary width x (15.0-25.0kPa) 
x L/2 and hyperstatic effects, note w.o./w. the differential (elastic, creep, shrinkage) axial shortening of 
adjacent supports. 
Note an arbitrary sign convention adopted for shear force (inconsistent with ADAPT-Builder). 
→ Stresses → Average (Precompression) → check TLS/SLS average precompression 0.7-2.5N/mm2 for slab 
and 2.5-4.5N/mm2 for beam. 

→ Stresses → Top → check TLS top stress f’min,t ≤ f’t ≤ f’max,t  
 BM:| -1.0 ≤ f’t ≤ 0.50fci [CL1] | -0.36√fci ≤ f’t ≤ 0.50fci [CL2] | -0.25fci ≤ f’t ≤ 0.50fci [CL3] | 

   FS:| -1.0 ≤ f’t ≤ 0.24fci [CL1] | -0.36√fci ≤ f’t ≤ 0.24fci [CL2] | -0.45√fci ≤ f’t ≤ 0.24fci [CL3] | 

→ Stresses → Bottom → check TLS bottom stress f’min,b ≤ f’b ≤ f’max,b  
 BM:| -1.0 ≤ f’b ≤ 0.50fci [CL1] | -0.36√fci ≤ f’b ≤ 0.50fci [CL2] | -0.25fci ≤ f’b ≤ 0.50fci [CL3] | 

   FS:| -1.0 ≤ f’b ≤ 0.33fci [CL1] | -0.36√fci ≤ f’b ≤ 0.33fci [CL2] | -0.45√fci ≤ f’b ≤ 0.33fci [CL3] | 

→ Stresses → Top → check SLS top stress fmin,t ≤ ft ≤ fmax,t  
 BM:| -0.0 ≤ ft ≤ 0.33fcu [CL1] | -0.36√fcu ≤ ft ≤ 0.33fcu [CL2] | -<.......> ≤ ft ≤ 0.33fcu [CL3] | 

   FS:| -0.0 ≤ ft ≤ 0.33fcu [CL1] | -0.36√fcu ≤ ft ≤ 0.33fcu [CL2] | -0.45√fcu ≤ ft ≤ 0.33fcu [CL3] | 

 Note -<.......> = MAX {-0.25fcu, (0.7-1.1).(-0.58√fcu to -0.82√fcu)-4N/mm2/1.0%}. 

→ Stresses → Bottom → check SLS bottom stress fmin,b ≤ fb ≤ fmax,b  
 BM:| -0.0 ≤ fb ≤ 0.40fcu [CL1] | -0.36√fcu ≤ fb ≤ 0.40fcu [CL2] | -<.......> ≤ fb ≤ 0.40fcu [CL3] | 

   FS:| -0.0 ≤ fb ≤ 0.24fcu [CL1] | -0.36√fcu ≤ fb ≤ 0.24fcu [CL2] | -0.45√fcu ≤ fb ≤ 0.24fcu [CL3] | 

 Note -<.......> = MAX {-0.25fcu, (0.7-1.1).(-0.58√fcu to -0.82√fcu)-4N/mm2/1.0%}. 
Note by convention, +ve stress is compressive and –ve stress is tensile (inconsistent with ADAPT-Builder). 
→ manually check rebar areas (to resist SLS tensile stress) required {As(d)xx, As(d)yy}, noting minimum 
steel. 
→ Investigation → Moment Capacity with Demand → check ULS moment capacity, Mu is greater than ULS 
bending effects MULS,E/E+MULS,S/E. 
→ manually check ULS shear capacity, Vu is greater than ULS shear effects VULS,E/E+VULS,S/E together with the 
associated required shear links Asv,req/S. 
LTD2 → VSS → FEM → Generate Rebar Drawing → check rebar (to resist SLS tensile stress) required in 
X/Y directions. 

8.24 Note here that in the following subsection, slab refers to transfer slab and slabs in the vicinity of transfer beams 
and beam refers to transfer beam. 
 
RC or PT Analysis and Design Summary Report 
LTD2 → VSS → RPT-T → Design Section Data → Design Section Forces Tabular Report → check design strip 
design sections forces. 
LTD2 → VSS → RPT-T → Design Section Data → Design Section Rebar Tabular Report → check design strip 
design sections rebar. 
LTD2 → VSS → RPT-T → Design Section Data → Design Section Moment Capacities → check design strip design 
sections moment capacities. 
LTD2 → VSS → RPT-T → Design Section Data → Design Section Dimension → check design strip design sections 
dimensions. 
LTD2 → VSS → RPT-T → Design Section Data → Design Section Geometry → check design strip design sections 
geometry. 
LTD2 → VSS → RPT-G → Tendon/Rebar Plan → check tendon and rebar plans. 

 

8.25 Manually check ULS shear stresses and shear design at beam/wall supports of transfer slabs.  

8.26 LTD2 → VSS → FEM → Punching Shear Check → check ULS punching shear at wall/column supports of 
transfer slabs. 
LTD2 → VSS → RPT-T → Punching Shear Design → Punching Shear Stress Check Result → check punching shear 
stress results. 
LTD2 → VSS → RPT-T → Punching Shear Design → Punching Shear Stress Check Parameters → check punching 
shear stress parameters. 
LTD2 → VSS → RPT-T → Punching Shear Design → Punching Shear Reinforcement → check punching shear 
reinforcement. 

 

8.27 Manually check ULS shear stresses and shear design at transferred walls on transfer slabs.  

8.28 Manually check ULS punching shear at transferred walls/columns on transfer slabs.  
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ITEM CONTENT  

8.3 FE Model Ill-Conditioning  

8.31 Building Analysis Method 
BA → Reports → Export Tributary Loads Check → check consistency between the applied un-decomposed loads 

tables and the reactions presented in the FEM loads tables. 
Load Take Down Method 
LTD1 → Reports → Export Tributary Loads Check → check consistency between the applied un-decomposed 
loads tables and the reactions presented in the cumulative loads tables. 

 

8.4 Load Take Down  

8.41 BA/LTD1 → Reports → Export Tributary Loads Check → check SLS load  15.0-25.0kPa for typical concrete 

residential and commercial buildings (ES). Note check load take down calculation for BA / LTD1. 
 

8.42 BA → VFS → RDS → Wall/Column → Actions (Diagram) → filtering out beams to only show walls/columns, check 
Axial Force in all walls/columns to visually inspect the sensibility of the load take down, e.g. only compression 
loads in walls/column, no zero loads to ensure no erroneous unattached walls/columns and no tension 
loads to ensure no erroneous hanging walls/columns. 
BA → VSS → RPT-G → Wall/Column Reactions → enable display of Axial Force, Moment and Shear for 
appropriate Loading Combinations to visually display Bottom loading effects, noting that directions rr and 
ss refer to the local axes (i.e. axis direction rr and ss, respectively) → check Axial Force (ensuring no uplift) for 
all walls/columns and Axial Force (ensuring no uplift), Moment and Shear for stability walls/columns (ES but 
primarily above the transfer floor and foundations). In addition for EQ combination cases, EQ base shear force 
for foundations to be calculated with the lateral and vertical EQ loads in the EQ combination cases enhanced by 
the overstrength and multiplicative factors, Rd. as per cl.4.4.2.6 BS EN1998-1. Note perform load take down 

calculation and likewise foundation SLS load combinations reporting for BA only. 
LTD1 → VSS → RDS → Load Takedown → Cumulative Loads to visually display Bottom loading effects → 
check axial force (moment and shear N/A) for all walls/columns. Note perform load take down calculation and 
likewise foundation SLS load combinations reporting for LTD1 only. 

 

8.5 Sway Susceptibility (NHF, Wind, EQ)  

8.51 Check Sway Classification Report Q ≤ 0.05 for   20 for BA / LTD2, else amplify lateral loads (wind, EQ) with 

the amplified sway factor, m = /(−1) to a maximum of m = 1.33 corresponding to Q ≤ 0.25 and   4.0 as the 

limit of linearity of the static analysis (cl.R6.2.6 ACI 318-14). 
• ULS sway susceptibility to NHF / wind load combinations should be analysed with modified default stiffness 

parameters {Class 1 PT or Class 2 PT slab/beam: kE=2.0, kI=0.7, kJ=0.7; RC or Class 3 PT slab/beam: 
kE=2.0, kI=0.35, kJ=0.35; wall/column: kE=2.0, kI=0.7, kJ=0.7} and other lateral load combinations (EQ) 
deleted. 

• ULS sway susceptibility to EQ load combinations should be analysed with modified default stiffness 
parameters {Class 1 PT or Class 2 PT slab/beam: kE=2.0, kI=0.7, kJ=0.7; RC or Class 3 PT slab/beam: 
kE=2.0, kI=0.35, kJ=0.35; wall/column: kE=2.0, kI=0.35, kJ=0.35} and other lateral load combinations (NHF, 
wind) deleted. Further, the lateral EQ displacements from the SLS EQ load combinations are to be enhanced 
by the adopted behaviour factor, q as per cl.4.3.4 BS EN1998-1. 

 

8.6 Lateral Deflections / Torsional Twist  

8.61 BA → VSS → RDS → Wall/Column → Deformation → rr/ss-Translation → optionally check total building lateral 

deflections to NHF, total ≤ Htotal/500 and relative storey drift, storey,I ≤ hstorey,I/500 (ES). NHF load combinations 

should be analysed with modified default stiffness parameters {Class 1 PT or Class 2 PT slab/beam: kE=2.0, 
kI=1.0, kJ=1.0; RC or Class 3 PT slab/beam: kE=2.0, kI=0.5, kJ=0.5; wall/column: kE=2.0, kI=1.0, kJ=1.0}, NHF 
load factors reset to 1.0, other lateral load combinations (wind, EQ) deleted and as a last resort adopting flanged 
beam sections in lieu of rectangular beam sections. 

 

8.62 BA → VSS → RDS → Wall/Column → Deformation → rr/ss-Translation → optionally check on-plan torsional 
twist due to NHF indicating if the offset between the centre of gravity / mass and centre of stiffness is ≤ 
span/500 (ES). NHF load combinations should be analysed with modified default stiffness parameters {Class 1 PT 
or Class 2 PT slab/beam: kE=2.0, kI=1.0, kJ=1.0; RC or Class 3 PT slab/beam: kE=2.0, kI=0.5, kJ=0.5; 
wall/column: kE=2.0, kI=1.0, kJ=1.0}, NHF load factors reset to 1.0, other lateral load combinations (wind, EQ) 
deleted and as a last resort adopting flanged beam sections in lieu of rectangular beam sections. 

 

8.63 BA → VSS → RDS → Wall/Column → Deformation → rr/ss-Translation → check total building lateral deflections 

to wind, total ≤ Htotal/500 and relative storey drift, storey,I ≤ hstorey,I/500 (ES) to cl.3.2.2.2 BS8110-2. SLS wind 

load combinations should be analysed with modified default stiffness parameters {Class 1 PT or Class 2 PT 
slab/beam: kE=2.0, kI=1.0, kJ=1.0; RC or Class 3 PT slab/beam: kE=2.0, kI=0.5, kJ=0.5; wall/column: kE=2.0, 
kI=1.0, kJ=1.0}, wind load factors reset to 1.0, other lateral load combinations (NHF, EQ) deleted and as a last 
resort adopting flanged beam sections in lieu of rectangular beam sections. 

 

8.64 BA → VSS → RDS → Wall/Column → Deformation → rr/ss-Translation → check on-plan torsional twist due to 
wind indicating if the offset between the centre of elevation and centre of stiffness is ≤ span/500 (ES). SLS wind 
load combinations should be analysed with modified default stiffness parameters {Class 1 PT or Class 2 PT 
slab/beam: kE=2.0, kI=1.0, kJ=1.0; RC or Class 3 PT slab/beam: kE=2.0, kI=0.5, kJ=0.5; wall/column: kE=2.0, 
kI=1.0, kJ=1.0}, wind load factors reset to 1.0, other lateral load combinations (NHF, EQ) deleted and as a last 
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resort adopting flanged beam sections in lieu of rectangular beam sections. 

8.65 BA → VSS → RDS → Wall/Column → Deformation → rr/ss-Translation → check total building lateral deflections 

to EQ, .q.total ≤ Htotal/250 and relative storey drift, .q.storey,I ≤ hstorey,I/250 (ES) as per cl.4.4.3.2 BS EN1998-

1. SLS EQ load combinations should be analysed with modified default stiffness parameters {Class 1 PT or Class 
2 PT slab/beam: kE=2.0, kI=1.0, kJ=1.0; RC or Class 3 PT slab/beam: kE=2.0, kI=0.5, kJ=0.5; wall/column: 
kE=2.0, kI=0.5, kJ=0.5} and other lateral load combinations (NHF, wind) deleted. Further, the lateral EQ 
displacements from the SLS EQ load combinations are to be enhanced by the adopted behaviour factor, q as per 
cl.4.3.4 BS EN1998-1. 

 

8.66 BA → VSS → RDS → Wall/Column → Deformation → rr/ss-Translation → check on-plan torsional twist due to EQ 
indicating if the offset between the centre of gravity / mass and centre of stiffness is ≤ span/500 (ES). SLS EQ 
load combinations should be analysed with modified default stiffness parameters {Class 1 PT or Class 2 PT 
slab/beam: kE=2.0, kI=1.0, kJ=1.0; RC or Class 3 PT slab/beam: kE=2.0, kI=0.5, kJ=0.5; wall/column: kE=2.0, 
kI=0.5, kJ=0.5} and other lateral load combinations (NHF, wind) deleted. Further, the lateral EQ displacements 
from the SLS EQ load combinations are to be enhanced by the adopted behaviour factor, q as per cl.4.3.4 BS 
EN1998-1. 

 

8.7 Beam Design  

8.71 Check design status of RC beams (ES). 
Check design status of PT beam design strips design sections (ES). 

 

8.72 In RC models, check beam rebar design for BA / LTD2 (ES). 
In PT models, check beam design strip design sections tendons (and rebar) design for BA / LTD2 (ES). 

 

8.73 In RC models, check common beam details in all similar storeys and between similar beams within the storey 
(ES). 
In PT models, check common beam details in all similar storeys and between similar beams within the storey 
(ES). 

 

8.74 In RC models, check % steel << 4% and design shear stress  3N/mm2 << 5N/mm2 for BA / LTD2 (ES 

including similar storeys). 
In PT models, check design shear stress  3N/mm2 << 5N/mm2 for BA / LTD2 (ES including similar storeys). 

 

8.75 In RC models, check beam detailed design report for BA / LTD2 (ES including similar storeys). 
In PT models, check beam detailed design report for BA / LTD2 (ES including similar storeys). 

 

8.76 In RC and PT models, manually perform ULS longitudinal shear check within web and between web and 
flanges for heavily loaded transfer beams if ULS shear stresses are greater than those stipulated on T.5.5 
BS8110-1 for BA / LTD2. Manually perform deep beam design for the transfer beam should the span to depth 
ratio be ≤ 2.0 simply-supported or 2.5 continuous (CIRIA Guide 2). Manually perform strut and tie truss analogy 
design for the transferred wall (acting as the diagonal compression element) and transfer beam (acting as the 
tension element). 

 

8.77 In RC models, manually check compliance to the deflection criteria for non-prismatic beams by recalculating the 
actual span / depth ratio based on the total beam span instead of the segmented beam span for BA / LTD2 
(ES). 

 

8.78 Building RC and PT beam final comprehensive design check (ES) #A  

8.781 BA → check design → % steel << 4% →   3 << 5N/mm2 →  

8.782 LTD2 → check design → % steel << 4% →   3 << 5N/mm2 →  

 #A Note for models with EQ loads, ULS EQ load combinations should be analysed on models with the following modified 
default stiffness parameters {Class 1 PT or Class 2 PT slab/beam: kE=1.0, kI=1.0, kJ=1.0; RC or Class 3 PT slab/beam: kE=1.0, 
kI=0.5, kJ=0.5; wall/column: kE=1.0, kI=0.5, kJ=0.5}. 

 

8.79 Manual modification of RC and PT beam detailing as follows: - 
(a)  incorporation of outer perimeter torsion links at heavily loaded transfer beam sections. 
(b)  elongation of rebar and links for the portions of transfer beam beneath transferred walls. 
(c)  inclusion of additional shear links / hooks  for very wide beams to satisfy the 150mm maximum spacing 

requirement of cl.3.12.7.2 BS8110-1 (ES). 
(d)  appropriate enhancement to non-prismatic beams (ES). 
(e)  search for single rebar specification, e.g. 1T12, 1T16, 1T20, 1T25, 1T32 or 1T40 within the beam dxfs (ES). 
(f) for models with EQ loads stabilised by moment frames, enhancement to the primary seismic beam 

maximum link spacing, s should be provided based on cl.5.4.3.1.2 BS EN1998-1 (DCM) which states s = 
min {beam depth / 4; 24 x link diameter; 225mm; 8 x longitudinal bar diameter} and cl.5.5.3.1.3 BS 
EN1998-1 (DCH) which states s = min {beam depth / 4; 24 x link diameter; 175mm; 6 x longitudinal bar 
diameter} (ES). 

 

8.8 Wall/Column Design  

8.81 Check design status of walls/columns (ES).  

8.82 Check for both frame analysis methods and both column design theories, i.e. BA + cl.3.8.4.5 BS8110-1 
theory, BA + biaxial bending theory, LTD2 + cl.3.8.4.5 BS8110-1 theory and LTD2 + biaxial bending theory (ES). 
Note that the cl.3.8.4.5 BS8110-1 theory is more conservative (less economic) compared to the biaxial bending 
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theory. Note that the design of walls/columns to resist the cumulative moment and shear for LTD2 N/A. 

8.83 Check reinforcement only increases down the building and decreases up the building (in general).  

8.84 Check common column details between similar columns within the storey (ES).  

8.85 Check % steel for walls (i.e. sections without through-thickness shear links) << 2% and design shear stress  

3N/mm2 << 5N/mm2 for both frame analysis methods and both column design theories, i.e. BA + 
cl.3.8.4.5 BS8110-1 theory, BA + biaxial bending theory, LTD2 + cl.3.8.4.5 BS8110-1 theory and LTD2 + biaxial 
bending theory (ES). Note that the design of walls to resist the cumulative moment and shear for LTD2 N/A. 

 

8.86 Check % steel for columns (i.e. sections with through-thickness shear links) << 5% and design shear stress  

3N/mm2 << 5N/mm2 for both frame analysis methods and both column design theories, i.e. BA + 
cl.3.8.4.5 BS8110-1 theory, BA + biaxial bending theory, LTD2 + cl.3.8.4.5 BS8110-1 theory and LTD2 + biaxial 
bending theory (ES). Note that the design of columns to resist the cumulative moment and shear for LTD2 N/A. 

 

8.87 Check wall/column detailed design report → search for {< 15.0 or > 15.0} for walls/columns that are to be 
correctly defined as braced and {< 10.0 or > 10.0} for walls/columns that are to be correctly defined as 
unbraced (ES). 

 

8.88 Building wall/column final comprehensive design check (ES) #B, #C  

8.881 BA → BS8110-1 theory → check design → % steel << 2%/5% #A →   3 << 5N/mm2 →  

8.882 BA → biaxial bending theory → check design → % steel << 2%/5% #A →   3 << 5N/mm2 →  

8.883 LTD2 → BS8110-1 theory → check design → % steel << 2%/5% #A →   3 << 5N/mm2 →  

8.884 LTD2 → biaxial bending theory → check design → % steel << 2%/5% #A →   3 << 5N/mm2 →  

 #A Note for models with EQ loads stabilised by moment frames, the maximum primary seismic column % steel is 4%, not 5%. 
#B Note for models with EQ loads, ULS EQ load combinations should be analysed on models with the following modified 
default stiffness parameters {Class 1 PT or Class 2 PT slab/beam: kE=1.0, kI=1.0, kJ=1.0; RC or Class 3 PT slab/beam: kE=1.0, 
kI=0.5, kJ=0.5; wall/column: kE=1.0, kI=0.5, kJ=0.5}. 
#C Note enhance walls/columns as appropriate for accidental loads (e.g. car park vehicular impact loads) and as 
disproportionate collapse key elements. 

Note that the design of walls/columns to resist the cumulative moment and shear for LTD2 N/A. 

 

8.89 Manual modification of wall/column detailing as follows: - 
(a)  manual addition of nominal through-thickness links in column-like vertical elements detailed as walls (ES). 
(b) for models with EQ loads stabilised by moment frames, enhancement to the primary seismic column 

maximum link spacing, s should be provided based on cl.5.4.3.2.2 BS EN1998-1 (DCM) which states s = 
min {(minimum column dimension excluding cover and half link diameter) / 2; 175mm; 8 x longitudinal bar 
diameter} and cl.5.5.3.2.2 BS EN1998-1 (DCH) which states s = min {(minimum column dimension 
excluding cover and half link diameter) / 3; 125mm; 6 x longitudinal bar diameter} (ES). 

 

9.0 FOUNDATION CHECKS  

9.1 General   

9.11 Check Allowable Soil Stress Ultimate Strength Factor = (1.4DL+1.4SDL+1.6LL)/(DL+SDL+LL), 1.4 being 
conservative. 

 

9.2 Pad Footing  

9.21 Check Footing Depth, Surcharge Height and Allowable Stress of Soil. Note perform load take down calculation for 
BA / LTD2 for all load combinations. Note that the design of foundations for walls/columns to resist the 
cumulative moment and shear for LTD2 N/A. 

 

9.22 Perform a detailed design check of all pad footings for BA / LTD2 for all load combinations. Note that the design 
of foundations for walls/columns to resist the cumulative moment and shear for LTD2 N/A. 

 

9.3 Strip Footing  

9.31 Check allowable stress of soil (kPa). 
Check coefficient of subgrade reaction (kN/m3). 

 

9.32 Check range of Subgrade Coefficients, Footing Width and Footing Depth. Note perform load take down 
calculation for BA / LTD2 for all load combinations. Note that the design of foundations for walls/columns to 
resist the cumulative moment and shear for LTD2 N/A. 

 

9.33 Perform a detailed design check of all strip footings for BA / LTD2 for all load combinations. Note that the design 
of foundations for walls/columns to resist the cumulative moment and shear for LTD2 N/A. 

 

9.34 Check (strip footing) beam detailed design report for BA / LTD2 for all load combinations. Note that the design 
of foundations for walls/columns to resist the cumulative moment and shear for LTD2 N/A. 

 

9.4 Raft / Piled Raft Footing  

9.41 Check allowable stress of soil (kPa). 
Check coefficient of subgrade reaction (kN/m3). 
Check pile SWL and vertical Pile Spring Coefficient. 
Ensure no uniformly distributed SDL or LL on the raft / piled raft as this will not translate into bending or shear 
effects on the raft / piled raft, instead employ point loads with their spacing distributed to depict reality. 
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9.42 Check raft / piled raft analysis by choosing not to Ignore Bearing Capacity of Soil. Note perform load take down 
calculation for BA / LTD2 for all load combinations. Note that the design of foundations for walls/columns to 
resist the cumulative moment and shear for LTD2 N/A. 

 

9.43 Check raft / piled raft SLS rotations  1/250 to BS8110-2 cl.3.2.1.1 (note the Stiffness Factors (i.e. factor for 

bending rigidity EI) for (raft strip) beam and (raft) slab elements should be set to (2/3rd).(0.50)0.32 (the 

further 2/3rd reduction factor applied to simulate the additional deflection due to creep to storage loading instead 
of normal loading (i.e. creep coefficient, =2 for storage loading instead of =1 for normal loading))). Note 

perform load take down calculation for BA / LTD2 for all load combinations. Note that the design of foundations 
for walls/columns to resist the cumulative moment and shear for LTD2 N/A. 
Check raft / piled raft SLS tilt  1/400 (note that tilt is unaffected by E and I values but instead is dependent 

only on the loading magnitude and distribution and the soil stiffness). Note perform load take down calculation 
for BA / LTD2 for all load combinations. Note that the design of foundations for walls/columns to resist the 
cumulative moment and shear for LTD2 N/A. 

 
Note if necessary, the simulation of the beneficial effect of additional reinforcement in controlling deflections can 
be made by factoring down the exhibited deflections by the ratio of the modified span / effective depth to the 
ratio of the basic span / effective depth (cantilever 7.0, simply supported 20.0, continuous 26.0). 

 

9.44 Check raft / piled raft |Mxx|+|Mxy| and |Myy|+|Mxy| → manually check rebar areas required {As(d)xx, As(d)yy}, 
noting minimum steel. Note perform load take down calculation for BA / LTD2 for all load combinations. Note 
that the design of foundations for walls/columns to resist the cumulative moment and shear for LTD2 N/A. 

 

9.45 Check raft / piled raft soil pressure. Note perform load take down calculation for BA / LTD2 for all load 
combinations. Note that the design of foundations for walls/columns to resist the cumulative moment and shear 
for LTD2 N/A. 

 

9.46 Manually check raft ULS shear stresses and shear design at beam/wall framing. Note perform load take down 
calculation for BA / LTD2 for all load combinations. Note that the design of foundations for walls/columns to 
resist the cumulative moment and shear for LTD2 N/A. 

 

9.47 Check raft ULS punching shear at wall/column framing. Note perform load take down calculation for BA / LTD2 
for all load combinations. Note that the design of foundations for walls/columns to resist the cumulative moment 
and shear for LTD2 N/A. 

 

9.48 Check (raft strip) beam detailed design report for BA / LTD2 for all load combinations. Note that the design of 
foundations for walls/columns to resist the cumulative moment and shear for LTD2 N/A. 

 

9.49 Check factored pile forces (ensuring no tension due to uplift) against the factored pile capacity (especially for 
stability walls attracting significant moments obscuring the obvious adequacy of the pile group capacity). Note 
perform load take down calculation for BA / LTD2 for all load combinations. Note that the design of foundations 
for walls/columns to resist the cumulative moment and shear for LTD2 N/A. 

 

9.5 Pile Footing  

9.51 Check pile SWL, Pile Size, vertical pile Spring Coefficient, Pile Cap Depth and Surcharge Height. Note perform 
load take down calculation for BA / LTD2 for all load combinations. Note that the design of foundations for 
walls/columns to resist the cumulative moment and shear for LTD2 N/A. 

 

9.52 Perform a detailed design check of all pile footings for BA / LTD2 for all load combinations. Note that the design 
of foundations for walls/columns to resist the cumulative moment and shear for LTD2 N/A. 

 

9.53 Note for pile caps with complex geometries (i.e. more than 4 pile pile-groups), employ the concepts of piled raft 
analysis and design choosing to Ignore the Bearing Capacity of Soil and incorporating the soil surcharge loads 
into the (pile cap) slab superimposed dead loads. 

 

10.0 QUANTITY CHECKS  

10.1 General  

10.11 VFS → RPT-T → Quantity and Cost → check estimate of the concrete volume (m3). 
Check estimate of the formwork area (m2). 

 

LPB 

LSB 

LFR 

LS 
LS : (raft) slab deflection check 
 

LSB : secondary (raft strip) 
beam deflection check 
 

LPB : primary (raft strip) beam 
deflection check 
 

LFR : frame (column to 
column) deflection check 

 

LPB 

LSB 

LFR 

LS 
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VFS → RPT-T → Quantity and Cost → check estimate of the steel / tendon quantity (kg). 

10.12 In RC or PT models, check concrete quantity to typical concrete equivalent floor thicknesses (m3/103m2) → 250-
500. 
In RC or PT models, check formwork quantity to typical formwork rates (m2/m2) → 1.5-2.5. 
In RC models, check rebar quantity to typical rebar tonnages (kg/m3) → one-way or two-way slabs 75-100, flat 
slabs 125-175, transfer slabs 150-350, beams 125-250, transfer beams 150-350, walls 100, columns 150-300, 
pile caps 150-200. 
In PT models, check tendon quantity to typical tendon tonnages (kg/m3) → slabs 20-25, transfer slabs 20-25, 
beams 40-50. In PT models, check rebar quantity to typical rebar tonnages (kg/m3) → slabs 20-35, transfer slabs 
40-70, beams 40-70. 
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Appendix A: PT Permissible Stress 
 

Permissible Stress [N/mm2] [BS8110, TR.43] 

 
Serviceability Class 1 
No Flexural Tensile 

Stresses 

Serviceability Class 2 
Flexural Tensile Stresses, 

Uncracked  
(No Visible Cracking) 

Serviceability Class 3 
Flexural Tensile Stresses, 

Cracked 

 Top Bottom Top Bottom Top Bottom 

TLS  
comp  

f’max,t/b 

0.50 fci #A1 

0.24 fci #A2 

0.50 fci #A1 

0.33 fci #A2 

0.50 fci #A1 

0.24 fci #A2 

0.50 fci #A1 

0.33 fci #A2 

0.50 fci #A1 

0.24 fci #A2 

0.50 fci #A1 

0.33 fci #A2 

TLS  
tensile  
f’min,t/b 

-1.0 #B -1.0 #B -0.36 fci #B -0.36 fci #B 
-0.25 fci #B1 

-0.45 fci #B2 

-0.25 fci #B1 

-0.45 fci #B2 

SLS  
comp  
fmax,t/b 

0.33 fcu #C1 

0.33 fcu #C2 

0.40 fcu #C1 

0.24 fcu #C2 

0.33 fcu #C1 

0.33 fcu #C2 

0.40 fcu #C1 

0.24 fcu #C2 

0.33 fcu #C1 

0.33 fcu #C2 

0.40 fcu #C1 

0.24 fcu #C2 

SLS  
tensile  
fmin,t/b 

-0.0 #D -0.0 #D -0.36 fcu #D -0.36 fcu #D 
-<.......> #D1 

-0.45 fcu #D2 

-<.......> #D1 

-0.45 fcu #D2 

#A1: Note beam, one-way slab or two-way slab option to cl.4.3.5.1 BS8110. 
#A2: Note flat slab option to T.2 TR.43 and cl.6.10.2 TR.43. 
#B: Note beam, one-way slab, two-way slab or flat slab option to cl.4.3.5.2 BS8110. 
#B1: Note beam, one-way slab or two-way slab option to cl.4.3.5.2 BS8110. 
#B2: Note flat slab option to T.2 TR.43 and cl.6.10.2 TR.43 based on full tributary width design strip. 
#C1: Note beam, one-way slab or two-way slab option to cl.4.3.4.2 BS8110. 
#C2: Note flat slab option to T.2 TR.43. 
#D: Note beam, one-way slab, two-way slab or flat slab option to cl.4.3.4.3 BS8110. 
#D1: Note beam, one-way slab or two-way slab option to cl.4.3.4.3 BS8110. Note -<.......> = MAX {-0.25fcu, (0.7-1.1).(-0.58√fcu to -0.82√fcu)-
4N/mm2/1.0%} as the code allows for an increase in the tensile stress limit from 1% of longitudinal steel (untensioned reinforcement) onwards (-
4N/mm2 for every 1% of longitudinal steel (untensioned reinforcement), increasing proportionally, up to the specified upper limit of -0.25fcu). 
#D2: Note flat slab option to T.2 TR.43 based on full tributary width design strip. 

 

Table 4.2 – Design Hypothetical Flexural Tensile Stresses for Class 3 Members [N/mm2] 

Group 
Limiting Crack Width  

[mm] 

Design Stress for Concrete Grade 

30 40 50 

Grouted  
Post-Tensioned Tendons 

0.1 3.2 4.1 4.8 

0.2 3.8 5.0 5.8 

 

Table 4.3 – Depth Factors for Design Tensile Stresses for Class 3 Members 

Depth of Member [mm] Factor 

≤ 200 1.1 

400 1.0 

600 0.9 

800 0.8 

≥ 1000 0.7 

 

Permissible Stress [N/mm2] [ACI318] 

 
Serviceability Class U 

Uncracked 
Serviceability Class T 

Transition 
Serviceability Class C 

Cracked 

 Top Bottom Top Bottom Top Bottom 

TLS  
comp  

f’max,t/b 
0.60 fci’ #A 0.60 fci’ #A 0.60 fci’ #A 0.60 fci’ #A 0.60 fci’ #A 0.60 fci’ #A 

TLS  
tensile  
f’min,t/b 

-0.25 fci’ #B -0.25 fci’ #B -0.25 fci’ #B -0.25 fci’ #B 
-0.30 fci’ #B1 

-0.50 fci’ #B2 

-0.30 fci’ #B1 

-0.50 fci’ #B2 
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SLS  
comp  
fmax,t/b 

0.60 fc’ #C 0.60 fc’ #C 0.60 fc’ #C 0.60 fc’ #C 0.60 fc’ #C 0.60 fc’ #C 

SLS  
tensile  
fmin,t/b 

-0.62 fc’ #D1 

-0.50 fc’ #D2 

-0.62 fc’ #D1 

-0.50 fc’ #D2 

-1.00 fc’ #D1 

-0.50 fc’ #D2 

-1.00 fc’ #D1 

-0.50 fc’ #D2 

-0.30 fc’ #D1 

-0.50 fc’ #D2 

-0.30 fc’ #D1 

-0.50 fc’ #D2 

#A: Note beam, one-way slab, two-way slab or flat slab option to cl.24.5.3.1 ACI318. 
#B: Note beam, one-way slab, two-way slab or flat slab option to cl.24.5.3.2 ACI318. 
#B1: Note beam, one-way slab or two-way slab option analogous to cl.4.3.5.2 BS8110. 
#B2: Note flat slab option to cl.24.5.3.2.1 ACI318 based on full tributary width design strip. 

#C: Note beam, one-way slab, two-way slab or flat slab option to cl.24.5.4.1 ACI318. 
#D1: Note beam, one-way slab or two-way slab option to cl.24.5.2.1 ACI318 and analogous to cl.4.3.4.3 BS8110. 
#D2: Note flat slab option to cl.24.5.2.1 ACI318 based on full tributary width design strip. 

 

Permissible Stress [N/mm2] [AS3600] 

 
Serviceability Class U 

Uncracked 
Serviceability Class T 

Transition 
Serviceability Class C 

Cracked 

 Top Bottom Top Bottom Top Bottom 

TLS  
comp  

f’max,t/b 
0.50 fci’ #A 0.50 fci’ #A 0.50 fci’ #A 0.50 fci’ #A 0.50 fci’ #A 0.50 fci’ #A 

TLS  
tensile  
f’min,t/b 

-0.25 fci’ #B -0.25 fci’ #B -0.60 fci’ #B -0.60 fci’ #B 
-0.30 fci’ #B1 

-0.60 fci’ #B2 

-0.30 fci’ #B1 

-0.60 fci’ #B2 

SLS  
comp  
fmax,t/b 

0.50 fc’ #C 0.50 fc’ #C 0.50 fc’ #C 0.50 fc’ #C 0.50 fc’ #C 0.50 fc’ #C 

SLS  
tensile  
fmin,t/b 

-0.25 fc’ #D -0.25 fc’ #D -0.60 fc’ #D -0.60 fc’ #D 
-0.30 fc’ #D1 

-0.60 fc’ #D2 

-0.30 fc’ #D1 

-0.60 fc’ #D2 

#A: Note beam, one-way slab, two-way slab or flat slab option to cl.8.1.6.2 AS3600. 
#B: Note beam, one-way slab, two-way slab or flat slab option to cl.8.6.2 and cl.9.4.2 AS3600. 
#B1: Note beam, one-way slab or two-way slab option analogous to cl.4.3.5.2 BS8110. 
#B2: Note flat slab option to cl.9.4.2 AS3600 based on column strip tributary width design strip. 
#C: Note beam, one-way slab, two-way slab or flat slab option to cl.8.1.6.2 AS3600. 
#D: Note beam, one-way slab, two-way slab or flat slab option to cl.8.6.2 and cl.9.4.2 AS3600. 
#D1: Note beam, one-way slab or two-way slab option analogous to cl.4.3.4.3 BS8110. 
#D2: Note flat slab option to cl.9.4.2 AS3600 as an alternative to cl.6.9.5.3 AS3600 based on column strip tributary width design strip. 

 

Permissible Stress [N/mm2] [EC2 and TR.43-2] 

 
Serviceability Class U 

Uncracked 
Serviceability Class T 

Transition 
Serviceability Class C 

Cracked 

 Top Bottom Top Bottom Top Bottom 

TLS  
comp  

f’max,t/b 

0.50 fci’ #A1 

0.30 fci’ #A2 

0.50 fci’ #A1 

0.40 fci’ #A2 

0.50 fci’ #A1 

0.30 fci’ #A2 

0.50 fci’ #A1 

0.40 fci’ #A2 

0.50 fci’ #A1 

0.30 fci’ #A2 

0.50 fci’ #A1 

0.40 fci’ #A2 

TLS  
tensile  
f’min,t/b 

-0.21 fci’2/3 #B1 

-0.09 fci’2/3 #B2 

-0.21 fci’2/3 #B1 

-0.09 fci’2/3 #B2 

-0.21 fci’2/3 #B1 

-0.09 fci’2/3 #B2 

-0.21 fci’2/3 #B1 

-0.09 fci’2/3 #B2 

-0.30 fci’ #B1 

-0.27 fci’2/3 #B2 

-0.30 fci’ #B1 

-0.27 fci’2/3 #B2 

SLS  
comp  
fmax,t/b 

0.60 fc’ #C1 

0.40 fc’ #C2 

0.60 fc’ #C1 

0.30 fc’ #C2 

0.60 fc’ #C1 

0.40 fc’ #C2 

0.60 fc’ #C1 

0.30 fc’ #C2 

0.60 fc’ #C1 

0.40 fc’ #C2 

0.60 fc’ #C1 

0.30 fc’ #C2 

SLS  

tensile  
fmin,t/b 

-0.21 fc’2/3 #D1 

-0.09 fc’2/3 #D3 

-0.21 fc’2/3 #D1 

-0.09 fc’2/3 #D3 

-0.21 fc’2/3 #D1 

-0.09 fc’2/3 #D3 

-0.21 fc’2/3 #D1 

-0.09 fc’2/3 #D3 

-<.......> #D2 

-0.27 fc’2/3 #D3 

-<.......> #D2 

-0.27 fc’2/3 #D3 

#A1: Note beam, one-way slab or two-way slab option to cl.5.8.2 TR.43-2. 
#A2: Note flat slab option to T.4 TR.43-2 and cl.5.8.2 TR.43-2. 
#B1: Note beam, one-way slab or two-way slab option to cl.5.8.2 TR.43-2 and analogous to cl.4.3.5.2 BS8110. 
#B2: Note flat slab option to T.4 TR.43-2 and cl.5.8.2 TR.43-2 based on full tributary width design strip. 

#C1: Note beam, one-way slab or two-way slab option to cl.5.10.2.2 EC2. 
#C2: Note flat slab option to T.4 TR.43-2. 
#D1: Note beam, one-way slab or two-way slab option analogous to cl.5.8.2 TR.43-2. 
#D2: Note beam, one-way slab or two-way slab option to cl.5.8.1 TR.43-2. Note -<.......> = MAX {-0.30fc’, (-0.40fc’2/3 to -0.50fc’2/3)-
4N/mm2/1.0%} as the code allows for an increase in the tensile stress limit from 1% of longitudinal steel (untensioned reinforcement) onwards (-
4N/mm2 for every 1% of longitudinal steel (untensioned reinforcement), increasing proportionally, up to the specified upper limit of -0.30fc’). 
#D3: Note flat slab option to T.4 TR.43-2 based on full tributary width design strip. 

  



 

 

FEM Design Verification Checklist for ADAPT-Builder 2017 (Summary) 
 
 

 

© Maverick United | 4 July 2019   P a g e  | 28

   

Appendix B: PT Prestress Strand Types 
 

PT Prestress Strand Types 
s 

[mm] 
As 

[mm2] 
Ep 

[GPa] 
fpk 

[N/mm2] 
Fpk 

[kN] 

[ASTM A416] Grade 270 s = 12.7mm Strand 12.70 98.71 186.0 1860 183.7 

[ASTM A416] Grade 270 s = 15.24mm Strand 15.24 140.00 186.0 1860 260.7 

[BS5896] 7-Wire Super s = 12.9mm Strand 12.90 100.00 195.0 1860 186.0 

[BS5896] 7-Wire Super s = 15.7mm Strand 15.70 150.00 195.0 1860 279.0 

 
Appendix C: PT Tendon Duct Dimensions 
 

PT Tendon Ducts Horizontal DT,H and Vertical DT,V External Dimensions 

Maximum 
Number of 
Prestress 

Strands in Each 
Tendon, Ns 

Default for 0.5” 
Strands 

Default for 0.6” 
Strands 

Remark 

 
DT,H 

(mm) 
DT,V 

(mm) 
DT,H 

(mm) 
DT,V 

(mm) 
 

3 55 23 55 23 Default refers to flat ducts 

5 75 23 90 23 Default refers to flat ducts 

7 55 55 70 70 Default refers to round ducts 

12 80 80 85 85 Default refers to round ducts 

19 95 95 100 100 Default refers to round ducts 

27 100 100 115 115 Default refers to round ducts 

37 115 115 135 135 Default refers to round ducts 

42 125 125 145 145 Default refers to round ducts 
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Appendix D: RC or PT Load Combination Cases 
 

Load 
Combo 

Description 
Load Factor 

PT HYP DL SDL LL WLX WLY NHLX NHLY 

 Ultimate Limit State (ULS)          

ULS01 1.4DL+1.4SDL+1.6LL+HYP #A, #B − 1.0 1.4 1.4 1.6 − − − − 

ULS02 1.4DL+1.4SDL±1.0NHL+HYP #A, #C 
− 1.0 1.4 1.4 − − − 1.0 − 

− 1.0 1.4 1.4 − − − − 1.0 

ULS03 1.0DL+1.0SDL±1.0NHL+HYP #A 
− 1.0 1.0 1.0 − − − 1.0 − 

− 1.0 1.0 1.0 − − − − 1.0 

ULS04 
1.2DL+1.2SDL+1.2LL±1.0NHL 

+HYP #A, #C 

− 1.0 1.2 1.2 1.2 − − 1.0 − 

− 1.0 1.2 1.2 1.2 − − − 1.0 

ULS05 1.4DL+1.4SDL±1.4WL+HYP #A 
− 1.0 1.4 1.4 − 1.4 − − − 

− 1.0 1.4 1.4 − − 1.4 − − 

ULS06 1.0DL+1.0SDL±1.4WL+HYP #A 
− 1.0 1.0 1.0 − 1.4 − − − 

− 1.0 1.0 1.0 − − 1.4 − − 

ULS07 
1.2DL+1.2SDL+1.2LL±1.2WL 

+HYP #A 

− 1.0 1.2 1.2 1.2 1.2 − − − 

− 1.0 1.2 1.2 1.2 − 1.2 − − 

 Transfer Limit State (TLS)          

TLS01 1.0DL+1.15PT #D 1.15 − 1.0 − − − − − − 

 Serviceability Limit State (SLS)          

SLS01 1.0DL+1.0SDL+1.0LL+PT #A 1.0 − 1.0 1.0 1.0 − − − − 

SLS02 
1.0DL+1.0SDL+1.0LL±1.0NHL 

+PT #A 

1.0 − 1.0 1.0 1.0 − − 1.0 − 

1.0 − 1.0 1.0 1.0 − − − 1.0 

SLS03 
1.0DL+1.0SDL+1.0LL±1.0WL 

+PT #A 

1.0 − 1.0 1.0 1.0 1.0 − − − 

1.0 − 1.0 1.0 1.0 − 1.0 − − 

#A For 3D building finite element models, the load combinations inherently include the effects of differential (elastic, creep, shrinkage) axial 
shortening. For 2D floor plate models on the other hand, these load combinations shall be appended with a 30-year differential (elastic, creep, 
shrinkage) axial shortening load case based on a 10-day per floor staged construction analysis of the load combination case 1.4DL+1.4SDL, 
1.2DL+1.2SDL or 1.0DL+1.0SDL as appropriate. Calculation of the elastic, creep and shrinkage components of the axial shortening shall be based 
on cl.3.1.4 EC2. 
#B Note that it is ensured that the construction load combination is less onerous than ULS 01. 
#C Note that the load combination case 1.4DL+1.4SDL±1.0NHL+HYP need not be applied if it is deemed to be always less onerous than 
1.2DL+1.2SDL+1.2LL±1.0NHL+HYP. This will be the case always as long as [DL+SDL]/[DL+SDL+LL] ≤ 0.85. 
#D Note that for transfer storeys, the TLS load combination case only considers the self-weight of the particular storey (and not the self-weight 
from any upper storey) in its dead load case, DL. 

 

Load 
Combo 

Description 
Load Factor 

PT HYP DL SDL LL EQX EQY EQZ 

 Ultimate Limit State (ULS)         

EQ 
ULS01 

1.0DL+1.0SDL+2iLL1.0EQX+HYP 

1.0DL+1.0SDL+2iLL1.0EQY+HYP 

− 1.0 1.0 1.0 2i 1.0 − − 

− 1.0 1.0 1.0 2i − 1.0 − 

EQ 
ULS02 

1.0DL+1.0SDL+2iLL+HYP 

1.0EQX0.3EQY0.3EQZ 

1.0DL+1.0SDL+2iLL+HYP 

0.3EQX1.0EQY0.3EQZ 

1.0DL+1.0SDL+2iLL+HYP 

0.3EQX0.3EQY1.0EQZ 

− 1.0 1.0 1.0 2i 1.0 0.3 0.3 

− 1.0 1.0 1.0 2i 0.3 1.0 0.3 

− 1.0 1.0 1.0 2i 0.3 0.3 1.0 
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 Serviceability Limit State (SLS)         

EQ 
SLS01 

1.0DL+1.0SDL+2iLL1.0EQX+PT #A
 

1.0DL+1.0SDL+2iLL1.0EQY+PT #A 

1.0 − 1.0 1.0 2i 1.0 − − 

1.0 − 1.0 1.0 2i − 1.0 − 

EQ 
SLS02 

1.0DL+1.0SDL+2iLL+PT 

1.0EQX0.3EQY0.3EQZ #A 

1.0DL+1.0SDL+2iLL+PT 

0.3EQX1.0EQY0.3EQZ #A 

1.0DL+1.0SDL+2iLL+PT 

0.3EQX0.3EQY1.0EQZ #A 

1.0 − 1.0 1.0 2i 1.0 0.3 0.3 

1.0 − 1.0 1.0 2i 0.3 1.0 0.3 

1.0 − 1.0 1.0 2i 0.3 0.3 1.0 

#A Note that the lateral EQ loads in the EQ SLS combination cases here are not enhanced by the adopted behaviour factor, q as per cl.4.3.4 BS 
EN1998-1 as these EQ SLS combinations are required for PT SLS design and also represent the foundation load combination cases. The 
evaluation of EQ deflections should be based on an amplified (by the factor q) deflection value instead. 

 
Appendix E: RC or PT Design Strip Design Sections Equivalent Frame Method Integration of Effects Analysis vs FE 
Analysis Method Integration of Effects Analysis 
 

RC or PT Design Strip Design Sections 
Equivalent Frame Method Integration of 

Effects Analysis 

RC or PT Design Strip Design Sections FE 
Analysis Method Integration of Effects 

Analysis 

Does not consider the flat slab hogging moment 
stress concentrations, unconservatively 

Does consider the flat slab hogging moment stress 
concentrations, conservatively 

Does not inherently consider external loads and 
tendons outside of the design strip (but still offers 

an effect), unconservatively 

Does inherently consider external loads and 
tendons outside of the design strip (but still offers 

an effect), conservatively 
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Appendix F: PT Additional Detailing Requirements 
 
The following additional detailing requirements are required: - 
 

(i) the provision of minimum longitudinal steel (untensioned reinforcement) for unbonded tendon construction 
[cl.6.10.6 TR.43] 
 

(ii) the provision of flexural and restraining longitudinal and transverse steel (untensioned reinforcement) near 
restraining walls 

  
 

(iii) the provision of longitudinal and transverse steel (untensioned reinforcement) between tendon anchorages at flat 
slab edges [cl.6.13 TR.43] 

• parallel to the edge, untensioned and/or tensioned reinforcement to resist the ULS bending moment for a 
continuous slab spanning la, which is the centre to centre distance between (groups of) anchorages, evenly 
distributed across a width of 0.7la should be provided, and 

• perpendicular to the edge, untensioned reinforcement greater than 0.13%bh and 1/4 x parallel 
reinforcement, evenly distributed between the anchorages and extending MAX(la,0.7la+anchorage) should 
be provided 

  
 

(iv) the provision of minimum longitudinal steel (untensioned reinforcement) at column positions for all flat slabs of at 
least 0.075% of the gross concrete cross-sectional area, concentrated between lines that are 1.5 times the slab 
depth either side of the width of the column and extending 0.2L into the span, L [cl.6.10.6 TR.43] 
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Appendix G: PT Dual-Cast Construction 
 
Dual-cast construction may be simplistically simulated by: - 
 

(i) first, performing the first-cast PT structural analysis after 
• modelling the structure corresponding to the first-cast (e.g. a transfer storey structure with a reduced 

initial thickness without any upper storey superstructure walls that may provide a stiffening effect) 
• modelling the PT tendons corresponding to the first-cast only whilst excluding that of the second-cast 

(e.g. a transfer storey structure with PT tendons within the first-cast initial thickness only) 
• applying external superimposed dead and live loads corresponding to the first-cast (e.g. a transfer storey 

structure with external self-weight of the additional second cast included as superimposed dead load and 
construction live load) 

• defining a standard TLS load combination case, e.g. 1.0S+1.15PT 
• defining standard SLS/ULS load combination cases with PT load combination cases 

 
(ii) second, performing the first-cast PT design TLS/SLS/ULS checks whilst 

• recording the representative SLS stress at bottom face which should be positive (i.e. compressive) for 
the dual-cast construction method to be effective, however negative (i.e. tensile) stresses should be 
considered and recorded if indeed that is the case (noting that by convention, positive stress is 
compressive and negative stress is tensile) 

 
(iii) third, performing the second-cast PT structural analysis after 

• modelling the structure corresponding to the second-cast (e.g. a transfer storey structure with an 
increased final thickness and upper storey superstructure walls potentially providing a stiffening effect) 

• modelling the PT tendons corresponding to the second-cast only whilst excluding that of the first-cast 
(e.g. a transfer storey structure with PT tendons within the second-cast final thickness only) 

• modelling the additional first-cast PT tendon area as equivalent [factored by fpk/fy] bottom longitudinal 
steel (untensioned reinforcement) area for the PT design ULS bending and shear checks, although for any 
quantity take-off purposes, the second-cast bottom longitudinal steel (untensioned reinforcement) quantity 
should then be factored down and for completion, the second-cast PT tendon quantity factored up to 
include the first-cast PT tendon quantity 

• applying external dead, superimposed dead and live loads corresponding to the second-cast (e.g. a 
transfer storey structure with external dead, superimposed dead and live loads from the particular storey 
and all upper storeys) 

• defining a non-standard TLS load combination case to exclude the beneficial effect (of counteracting the 
prestressing equivalent load) of the self-weight of the second-cast structure section which can no longer be 
considered as it has already been considered in the bending of the first-cast structure section, e.g. 
0.0S+1.15PT, noting that all transfer storeys should thus be designated as such so that the dead load 
(self-weight of the structure) case, S within the TLS load combination case (thus defined when the type of 
load combination case is designated by the user as initial) will refer to the self-weight of only the 
particular storey (and not the self-weight from any upper storey) 

• defining standard SLS/ULS load combination cases with PT load combination cases, noting that the effect 
of the self-weight of the second-cast structure section can conservatively be double-counted, the effect 
being marginal in practice as it would be resisted by the full second-cast structure section elastic section 
modulus Zt/b and would form only a fraction of the full SLS load combination cases whilst ensuring that the 
correct external load effects are maintained for presentation purposes and other PT design SLS/ULS checks 

 
(iv) fourth, performing the second-cast PT design TLS/SLS/ULS checks whilst 

• subtracting the recorded first-cast representative SLS stress at bottom face from the criteria fmin'/fmin and 
fmax'/fmax 
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Appendix H: PT Multi-Stage Stressing 
 
Multi-stage stressing may be simplistically simulated by: - 
 

(i) first,  
• modelling the structure corresponding to the first stressing stage, STG(i=1) (e.g. a transfer storey 

structure with a reduced total number of upper storeys above the transfer storey)  
• modelling the PT tendons corresponding to the first stressing stage, STG(i=1) (e.g. a transfer storey 

structure with a reduced total number of PT tendons) 
• applying external superimposed dead and live loads corresponding to the first stressing stage, STG(i=1) 

(e.g. a transfer storey structure with external loads consistent with the reduced total number of upper 
storeys above the transfer storey) 

• defining a standard TLS load combination case, e.g. 1.0S+1.15PT, noting that all transfer storeys 
should thus be designated as such so that the dead load (self-weight of the structure) case, S within the 
TLS load combination case (thus defined when the type of load combination case is designated by the user 
as initial) will refer to the self-weight of only the particular storey (and not the self-weight from any upper 
storey) 

• defining standard SLS/ULS load combination cases with PT load combination cases  
• performing the PT structural analysis  
• performing the PT design TLS/SLS/ULS checks corresponding to the first stressing stage, STG(i=1) 

 
(ii) second,  

• modelling the structure corresponding to the second stressing stage, STG(i=2) (e.g. a transfer storey 
structure with an increased total number of upper storeys above the transfer storey)  

• modelling the PT tendons corresponding to the second stressing stage, STG(i=2) (e.g. a transfer storey 
structure with an increased total number of PT tendons) 

• applying external superimposed dead and live loads corresponding to the second stressing stage, STG(i=2) 
(e.g. a transfer storey structure with external loads consistent with the increased total number of upper 
storeys above the transfer storey) 

• defining a non-standard TLS load combination case to include the effects of the self-weight from the 
upper storeys corresponding to the preceding stressing stage (pre-calculated and applied as superimposed 
dead load), e.g. 1.0S+1.0SUPPER STOREYS OF STG(i=1)+1.15PT 

• defining standard SLS/ULS load combination cases with PT load combination cases 
• performing the PT structural analysis 
• performing the PT design TLS/SLS/ULS checks corresponding to the second stressing stage, STG(i=2) 

 

(iii) third and thereafter, repeating the second step corresponding to the third and thereafter stressing stages, STG(i=3, 
4, 5, etc.) 


